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Chapter 1 Introduction

NetTune PRO®  is a pioneer and leader in network performance software solutions.
NetTune PRO is designed to help network managers perform the following network
tasks:

• Capacity planning

• Troubleshooting

• Monitoring (of over 110 NetWare internals)

• Reporting and analysis

• Network optimization

Overview
NetTune PRO gives network managers a detailed view of every file server on the
network and provides instant access to both real-time and historical data.

The following statistical report categories are available for instant viewing and
analysis:

• NetWare

• LAN

• Network interface cards

• Connections

• Disk

• Memory

• Volumes

• NetWare Loadable Modules (NLMs)

Each category offers detailed information. Network managers no longer have to
search through multiple software programs or NetWare’s MONITOR.NLM to
monitor activity or track down problems.
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Network managers also can easily identify trends that negatively impact the
network. For example, large NLMs can degrade network performance because of
their large memory requirements. Using NetTune PRO, network managers can
instantly view and track memory allocation.

A server memory map is available along with complete information on each loaded
NLM. This feature allows network administrators to quickly determine the
following:

• Version numbers

• Dates

• RAM footprints

• Memory usage

Report Data

NetTune PRO compiles a valuable, user-defined historical database for up to 400
days. Data is accessible in the following formats:

• Standard reports

• User-customized reports

NetTune PRO includes 12 custom graphing and reporting alternatives including, 2-
D, 3-D, Bar, and Gantt charts.

Network Performance Optimization

The NetWare SET parameter values significantly affect how the server performs and
how the operating system responds to network requests.

Utilizing NetTune PRO real-time and historical statistical data to track server
workloads, network administrators can improve server performance using one of the
following NetTune PRO options:

• Manually adjust internal NetWare operating system’s SET parameters through
NetTune PRO’s Graphical User Interface.

• Create custom Tune files, and schedule SET parameter changes through those
custom Tune files.

• Have SmartTune automatically adjust server SET parameters on the fly, based
on real-time, decision-making algorithms.

NetTune PRO runs on the server as NLMs and on client workstations as a Windows
application.
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System Requirements

NetTune PRO has the following minimum system requirements for the file server
and the client workstations:

NetWare File Server

• NetWare 3.1X or NetWare 4.1X

• 170K of RAM for the NetTune PRO NLMs

Client Workstation

• IBM PC or compatible

• Microsoft Windows 3.1

• MS-DOS 5.0 or higher

• 4MB of RAM (8MB recommended)
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Chapter 2 Installation

Installing NetTune PRO on a Client Workstation
NetTune PRO’s installation program (SETUP.EXE) installs 22 files on the client
workstation.

Please note that in the following example the drive letter A: represents the floppy
location that contains the NetTune PRO setup program. If you are installing NetTune
PRO from the B: drive, replace any mention of A: with B:.

In the example, the Windows files are placed in a directory called WINDOWS. If
your Windows directory has a different name, the NetTune PRO setup program will
find it.

Running the NetTune PRO Setup Program

To install the NetTune PRO workstation software:

1. Start Windows.

2. From the Program Manager’s menu bar, select the File pull-down menu  and
choose Run.

3. The Run dialog box appears. Type a:\setup in the Command Line field.

4. Next, click on the OK button to accept the path you entered and run the install
program, SETUP.EXE.

After NetTune PRO initializes, a setup dialog box appears.

5. Click on the Continue button to begin the installation.
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A destination dialog box appears that reports the disk space that is required to
install NetTune PRO and the disk space that is available. The dialog box also
shows the default destination directory for the NetTune PRO installation.

6. If the default destination directory is acceptable, click on the Install button and
proceed to Step 7.

If this default destination is not acceptable, change the path by clicking on the
Set Location button. The NetTune PRO Destination path dialog box appears.
When you have typed in the desired NetTune PRO path, click on the Continue
button.

Once NetTune PRO has a valid destination path, it begins the install process.
During the install process, an installation meter shows the percentage of the
installation that has completed.

7. When SETUP.EXE completes the installation, a Success dialog box appears.

8. When you return to the Windows Program Manager, you will see a new
program group on the Windows desktop called BrightWorks. The new group
contains the NetTune PRO icons.
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Files Created by NetTune PRO

The setup program places twenty files in the NETTUNE directory. (NETTUNE is
the default directory name if a different name is not specified during the install.)

• NETTUNE.EXE - The workstation application program.

• NETTUNE.HLP - NetTune PRO’s help file.

• WIZARD.HLP - The help file for the NetTune PRO Advisor

• NET31X.NLM - The NetWare 3.1X data collection module.

• NET41X.NLM - The NetWare 4.1X data collection module

• NETTUNE.NLM - The engine for collecting the historical database information.

• NETCONVRT.NLM - The engine for conversion of database files from the
NetTune PRO 1.2 format.

• DPATCH.NLM - The disk statistics version 1.00 patch contains the Novell fix to
NetWare version 3.11. This patch is only required if you are running NetWare
version 3.11. When used, it allows statistical disk information to be collected.

• SMARTUNE.NLM - The engine that allows you to perform the following tasks:

• Manually modify SET parameters

• Edit NCF files

• Tune automatically

• Schedule Tune files

• TUNE3.NCF - The NetWare NCF file used to load the version 3 NLMs.

• TUNE4.NCF - The NetWare NCF file used to load the version 4 NLMs.

• UNTUNE3.NCF - The NetWare NCF file used to unload the version 3 NLMs.

• UNTUNE4.NCF - The NetWare NCF file used to unload the version 4 NLMs.

• GSW.EXE - The NetTune PRO graphics engine for Windows.

• NWCALLS.DLL - The interface between the Windows application and the
NetWare client code (NETX or VLMs).

• NWIPXSPX.DLL - The interface between the Windows application and the
NetWare client code (the VIPX and IPX).

• METER.DLL - Controls and displays the meter dialog components.

• MUSCROLL.DLL - Controls and displays the micro scroll bars dialog
components.
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• GSWDLL.DLL - The interface to the graphics engine.

• NETTUNE.WRI - Contains the latest NetTune PRO program information. This
file includes changes that were made after this manual was printed.

The setup program also places two files in the Windows directory.

• RCONSOLE.PIF - The program information file for running the RCONSOLE
program from within NetTune PRO.

• CTL3DV2.DLL - Gives dialog windows a 3-D effect.

Installing NetTune PRO on the Server
Double-click on the NetTune PRO icon in the BrightWorks program group.

After a first time install, NetTune PRO’s Quick Start dialog box appears and
presents you with optional, required, and recommended steps to get started with
NetTune PRO.

After the first install is completed, NetTune PRO’s Quick Start dialog box does not
display again. You can recall the Quick Start dialog box by selecting Quick Start
from the Help pull-down menu. The Quick Start command allows you to install
NLMs, view a server’s configuration, set up Recording Intervals, and create Groups
on the NetTune PRO desktop.
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NetTune PRO’s Quick Start dialog box contains six options:

• An introduction and overview of NetTune PRO
This step is optional. It loads NetTune PRO’s Help index.

• Modify the default recording intervals
This step is optional. It allows you to modify the default recording intervals to
the NLMs you subsequently install.

• Install NetTune PRO’s NLMs on one or more servers
This step is required. Without the NLMs installed and loaded, data collection
does not take place.

• Add the newly installed NetTune PRO servers to the Desktop
This step is required. Servers must be added to the desktop or to a group. If you
are installing NetTune PRO for the first time, you will add file servers to the
NetTune PRO default group called Desktop.

• Get a quick review of the servers configuration This step is recommended but
not required. Displayed information on server-related configurations is
available.

• Exit the Quick Start dialog box.

Using the Quick Start Dialog Box

To install the NetTune PRO file server software, follow the steps below.

NOTE: NetTune PRO automatically loads the NLMs into the SYSTEM directory of
the selected file server’s SYS: volume.

1. Click on button number 3 from NetTune PRO’s Quick Start dialog box. This
option allows you to install NetTune PRO’s NLM to one or more file servers.

2. NetTune PRO’s NLM Install dialog appears.

The Show Servers selection box has three options:

• Not Running NetTune PRO - Displays all of the file servers that currently
do not have NetTune PRO’s NLMs loaded.

• Running an Old Version of NetTune PRO- Displays all of the file servers
that currently have older versions of the NetTune PRO NLMs loaded.

• ALL - This displays all of the file servers without regard to their NetTune
PRO version.
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If this is a first-time install, select the Not Running NetTune PRO button. A list
of file servers that do not have NetTune PRO installed is displayed in the Server
box.

3. Select the file server(s) to be loaded with NLM software and click on the left
mouse button once. The Installation program allows you to make multiple file
server selections.

4. After selecting servers, click on the Install button.

During the NLM install process, an installation meter displays the percentage
completed.

When the NLM installation is complete, the RCONSOLE request dialog box
appears.

5. Selecting Yes causes NetTune PRO to automatically load Novell’s
RCONSOLE. This program provides a user interface for loading the NetTune
PRO NLMs.

RCONSOLE could fail to load for the following reasons:

• Not having console rights to that file server. Check that you are logged in as
SUPERVISOR or that you have console rights as a user.

• Not enough memory available. Try freeing up some resources to release
additional memory.

• The RCONSOLE.PIF contains the wrong path. Make sure the program
information file has the correct path to RCONSOLE.
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When the file server prompt appears, load the NetTune PRO module by typing
the NCF file name, TUNE.

NOTE:  The TUNE.NCF file automatically loads SMARTUNE.NLM in
read/write mode but with tuning disabled. To disable the write mode, edit the
TUNE.NCF file and remove the “W” option.

You have now completed Quick Start’s NLM install portion for your file server. If
you installed the NLMs to more than one server, it is necessary to connect to each
server through RCONSOLE and run the TUNE.NCF file. When you are finished,
exit RCONSOLE with the <Shift -Esc> key combination.

Installation Notes

Windows for Workgroups

During the install process, if you do not see any file servers listed in the Servers box,
Windows for Workgroups may not be set up for network use. To select an
appropriate network:

1. Double click on the network setup icon (from the Network group window).

2. Next, click on the Network button.

3. A dialog box appears. Select “Install Windows support for the following
network only.”

4. Next click on the scroll bar to open the Network selection window.

5. Now use the scroll bar to select the appropriate NetWare version.

6. When you are finished, click the OK button twice to save your settings.

Windows 3.1

If you do not see any file servers listed in the Servers box, Windows 3.1 may not be
set up for network use. To select an appropriate network:

1. Select the Windows Setup icon from the Main window.

2. Select Change System Settings from the Options pull-down menu.

3. Click on the Networks button and select the appropriate version of NetWare.

4. When the NLM installation complete, the RCONSOLE request dialog box
appears.
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Additional Notes on the NLM Install

NetTune PRO depends on other NLMs. When TUNE.NCF is executed at the file
server, dependent NLMs are automatically loaded. This process eliminates the
manual loading of NLMs from the server’s console.

The UNTUNE.NCF file automatically unloads the NLMs in the reverse order that
they were loaded.

To automate the task of loading NetTune PRO, place the load command at the
bottom of your AUTOEXEC.NCF file.

Files Copied to the Server During NLM Install

NetTune PRO installs the following NLM and NCF files:

• NET31X.NLM - The NetWare 3.1X data collection module (on 3.1X servers).

• NET41X.NLM - The NetWare 4.1X data collection module (on 4.1X servers).

• NETTUNE.NLM - The engine for collecting the historical database information.

• DPATCH.NLM - This disk statistics version 1.00 patch contains the Novell fix
to NetWare version 3.11 (on 3.11 servers).  This patch is only required if you
are running NetWare version 3.11. When used, it allows statistical disk
information to be collected.

• SMARTUNE.NLM - This NLM contains the engine that allows you to perform
the following tasks:

• Manually modify SET parameters

• Edit NCF files

• Tune automatically

• Schedule Tune files

• NETCONVRT.NLM - The engine to conversion database files from the NetTune
PRO 1.2 format.

• TUNE.NCF - NetWare NCF file used to load the NLMs.

• UNTUNE.NCF - NetWare NCF file used to unload the NLMs.
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Adding Servers to the NetTune PRO Desktop
NetTune PRO allows you to organize servers into groups, which allows you to
manage more servers and helps reduce clutter on the NetTune PRO desktop.

To associate a file server with NetTune PRO’s default group called Desktop:

1. Click on the number 4 button from NetTune PRO’s Quick Start dialog box.

2. The Group Management dialog box appears. The NetTune PRO Servers box
contains a list of servers loaded with NetTune PRO’s NLMs. Highlight the
server you want to place in the Desktop group by clicking on the file server’s
name.

NOTE: If you do not see any file servers listed in the Servers box, your
operating system (Windows for Workgroups or Windows 3.1) may not be set up
for network use. Please refer to Installation Notes  to address the problem.

3. The Add and Add All buttons are now selectable. Click on the Add button to
add the selected file server to the Desktop group. To add all the NetTune PRO
servers to the Desktop group, click on the Add All button.

4. After the file server has been added to the Desktop group, click on the Close
button to save the selection.
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The Group Management Dialog Box

The following command buttons are found in the Group Management dialog box:

Button Description

ADD The Add button adds the highlighted selected
server(s) to a selected group.

ADD ALL The Add All button adds all NetTune PRO
servers to a selected group.

CLOSE The Close button ends the session and exits
from the Group Management dialog box.

HELP The Help button brings up NetTune PRO
Help index.

SHOW The Show button displays all server and group
icons on NetTune PRO’s desktop.

HIDE The Hide button hides all server and group
icons from displaying on NetTune PRO’s
desktop.

DELETE The Delete button deletes a highlighted server
or group from a selected group.

NEW The NEW button creates a new group in the
Groups/Servers selection box.

RENAME The Rename button renames any selected
group.

Adding Additional Servers

To organize and manage the NetTune PRO desktop, you can arrange servers into
groups.

To create a new server group:

1. Select Group Management from the Options pull-down menu.

2. Next, click on the New button in the Group Management dialog box.

3. Next, click on the name field in the Group Management Name dialog box, and
enter a descriptive group name.

4. As an example, type the name “TEST GROUP” in the Name field, and click on
the OK button to save the new group.
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The newly created group name now appears in the Group Management dialog
box.

NOTE: NetTune PRO has a limit on the numbers of Groups and Servers per
Group. You can have a maximum of:

• groups, and

• servers per group.

5. In the Servers selection box, highlight the name(s) of all servers you want to add
to the new group and click on the Add button.

6. Click on the Close button to save your work.

The TEST GROUP icon now appears on the NetTune PRO desktop.
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Deleting Servers/Groups from the NetTune PRO Desktop

1. First, highlight the server/group in the Group/Servers selection box and click on
the Delete button.

2. After the decision dialog box appears, click on the Yes button to delete the
group/server from the NetTune PRO Desktop.

3. Click on the Close button to exit the Group Management dialog box.

Running RCONSOLE
The RCONSOLE option in the Tools menu automatically loads Novell’s
RCONSOLE. The remote console can be used as a virtual file server console to load
and unload NLMs from inside the NetTune PRO application.

If you have a problem loading RCONSOLE, from NetTune PRO, check that you
have console rights.

To exit RCONSOLE:

1. Pressing the <SHIFT-Esc> key combination.
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2. Answer Yes to the question “Exit Remote Console?,” and press the <Enter>
key.

Reference and Support Documentation
The following publications contain additional information related to the NetTune
PRO theory of operation, in addition to NetWare, and Microsoft Windows
operation:

• Microsoft Windows® User Guide

• Novell NetWare® Version 3.11 Concepts Manual

• Novell NetWare® Version 3.11 System Administration Manual

• Novell NetWare® Version 4.10 Concepts Manual

• Novell NetWare® Version 4.10 Supervising the Network Manual

• Novell NetWare® Version 4.10 Utilities Reference Manual

• Beyond the Basics: Maintaining and Optimizing NetWare® 3
by Edward Liebing

• Novell Support Encyclopedia on CD-ROM
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Chapter 3 Working with NetTune PRO

This section describes the components of the NetTune PRO user interface:

• The Control Menu Box is used to resize, move, maximize, minimize, close
windows, and switch to other window applications.

• The Window Title Bar displays the title of the currently active window.

• The Minimize Button reduces the current window to an icon.

• The Restore Button returns the window to its previous size.

• The Menu Bar lists all available pull-down menus for the current window.

• The Tool Bar lists all available tools for the current window.

• The Application Window is the NetTune PRO desktop.

• The Application Icons represent manageable objects on the NetTune PRO
desktop.

• The Status Bar displays information on the current menu selection, the
currently highlighted server name, NetWare version, and login name.

For a detailed review of the Windows interface, refer to your Microsoft Windows

User Guide.
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Menu Commands
The menus on the menu bar are used to display groups of NetTune PRO commands.

Menu Conventions Description

A dimmed command Command unavailable.

Ellipsis (...) following a
command

A dialog box appears when
this command is chosen.

A check mark next to a
command

Command currently in effect.

A triangle following a
command

A cascading menu appears
when this command is chosen.

In the Window menu bar, each of the commands contains an underlined letter in the
command name. To display the menu, hold down the <Alt> key and press the
underlined letter.

Many commands listed in the cascading menus have key combinations shown to the
right of the command. Sequentially press the two indicated keys to select the
command.

Dialog Boxes
NetTune PRO uses dialog boxes to request or provide information. If you select a
menu command followed by an ellipsis (...), a dialog box appears.

Push buttons, text boxes, selection boxes, pull-down selection boxes, radio buttons
and check boxes may appear in dialog boxes. Select an option using the mouse, and
click or press the Tab key repeatedly until the desired option is activated.

The following table lists the types of dialog box options.

Option Description

Command Push
Button

Initiates immediate action. Push buttons are
selected by clicking on the button with the
mouse, or by using the Tab and Enter keys.

Text Box Allows text insertion into entry field. Once
you select a text box, you can type an entry or
modify an existing entry. In some cases, you
may also use the scroll bar arrows next to the
text box to increase or decrease a number.
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Option Description

Selection Box Displays a list of choices. Click on choice.

Pull-down Selection
Box

Displays a list of choices. Highlight the
appropriate choice.

Radio Button Selects a mutually exclusive option.

Check Box Used for selecting multiple options. You can
toggle a check box option on or off by
selecting or deselecting the check box. When
the check box is selected (On), an X appears
inside the check box.

NetTune PRO Icons
An icon is a graphical representation of a NetTune PRO object that can be selected
and opened. There are five NetTune PRO icons:

NetTune PRO Program Icon

Double-clicking on the NetTune PRO icon
runs the program on the client.

File Server Icon

When a file server icon is selected, the server
name is highlighted and the menu bar reflects
the actions that can be performed on that
server. The NetWare version number appears
on the icon.

Statistical Report Icons

Statistical reports (either custom or
predefined) show server activity over a
specified time period. Once minimized, these
reports are represented by the Statistical
Report Icon.
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Information Text Icon

The Information Text Icon represents a
minimized text report based on information
located in the Information pull-down menu.
This icon differs from the statistical report
icon, which represents historical information.

Group Icon

The Group Icon represents a minimized
custom group which contains any file servers
associated with that group.

The NetTune PRO Toolbar
The Toolbar is a graphical bar with command icons that perform some of the most
common commands in the NetTune PRO program. The horizontal strip located
directly below the Menu bar is the Toolbar.

To use the Toolbar, move the mouse pointer to the icon representing the command
you want to execute, and click the mouse button.

The following are the toolbar icons and their functions:

Button Description

Saves the current file.

Cuts the selected text block and
places it on the clipboard.

Copies the selected text block to the
clipboard.
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Inserts a copy of the clipboard
contents.

Prints the active file.

Selects Date and Time interval and
Report type.

Increases the time interval of the
data currently being viewed.

Decreases the time interval of the
data currently being viewed.

Toggles between a graph or ASCII
text report.

Opens the graph options dialog box
to select a graphing option.

Toggles the Hot key feature On or
Off.
The Hot Key is On when the cursor
arrow is thick.
NOTE:  This feature consumes
memory.

Increases the data points on a
graph.
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Decreases the data points on a
graph.

Activates the Performance Advisor.

Displays the About NetTune PRO
information.

Context-sensitive help that displays
only the help information selected
by the mouse.

Status Bar
The Status Bar at the bottom of NetTune PRO’s desktop is displayed by default.

The Status bar provides the following information:

• Help key identification

• The highlighted (active) file server’s name

• The highlighted (active) file server’s NetWare version

• The user’s login name

• Information on the keyboard’s status
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Working with Windows and Icons
You can use the commands in the Window menu to control the display of
application windows. A number of optional commands are available in the pull-
down menu.

Selecting a Window

NetTune PRO permits you to have several windows and icons open simultaneously.
The Window command displays a list of the open icons and windows at the bottom
of the cascading menu. To select the window you want, click on the appropriate
name.

If more windows are open than can be displayed in the cascading menu, the
command “More Windows...” appears at the bottom of the Window menu. Click on
the More Windows command to open the Select Window dialog box.

The Select Window dialog box is used to view a list of all windows. Click on the
window you want to activate.

Arranging Windows

You can arrange the windows on your desktop in a number of ways:

• Cascade: The Cascade command is used to arrange all open application
windows so that they are visible in the NetTune PRO window. The command
causes the windows to overlap so that each open application’s title bar is visible.

• Tile Vertical: The Tile Vertical command is used to arrange all open
application windows so that they are visible in the NetTune PRO window. The
command causes the windows to vertically stack so that each open application
window is visible.

• Tile Horizontal: The Tile Horizontal command is used to arrange all open
application windows so that they are visible in the NetTune PRO window. The
command causes the windows to horizontally stack so that each open
application window is visible.

Arranging Icons

The Arrange Icons command is used to organize all scattered icons. The command
causes the icons to align at the bottom of the NetTune PRO window so that each
icon is visible.
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Saving the NetTune PRO Desktop

To save the NetTune PRO desktop when quitting NetTune PRO, choose the Save
Settings on Exit command from the options menu. A check mark next to the
command means it is in effect.

By default, NetTune PRO saves the desktop in the NETTUNE.INI file. When the
NetTune PRO program is started, NETTUNE.INI  is used to restore the desktop.

You can create additional custom desktop INI files for NetTune PRO containing
other desktop settings.

To open a custom desktop INI file:

1. From NetTune PRO, press ALT+TAB and switch to the Windows Desktop.

2. Click once on NetTune PRO’s icon from the Windows Program Manager
desktop.

3. Select the File pull-down menu from the Windows Program Manager menu bar.

4. Select Properties from the File pull-down menu.

Go to the Command Line field in the Program Item Properties dialog box. At
the end of the path string for NetTune PRO, insert a space and enter the desired
substitute INI file name.

The next time you enter NetTune PRO, the desktop uses the new INI file you
entered.

To undo the Save Settings On Exit command:

Select Save Settings On Exit from the Options pull-down menu. This action
removes the check mark and means the command is no longer in effect.
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Editing Configuration Files
You can use NetTune PRO’s built-in text editor to edit configuration files. Click on
Edit in the menu bar to access the editing commands.

Editing Overview

There are three basic text editing techniques:

• Inserting text

• Deleting text

• Blocking text

Inserting Text

Position the cursor to the spot in the file where you want to insert text and begin
typing.

Deleting Text

Position the cursor to the left of the text you want to delete, and press the Delete key.
If you prefer, position the cursor to the right of the text to be deleted, and press the
Backspace key.

Blocking Text

A block of text is any group of characters you have highlighted. The editor treats the
highlighted text as a single unit.
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Keyboard Navigation

The following keyboard navigation commands are available in the text editor:

Key Moves the Cursor

Left Arrow Left one character

Right Arrow Right one character

Up Arrow Up one line

Down Arrow Down one line

Home To the beginning of the current
line

End To the end of the current line

Page Up Up one screen

Page Down Down one screen

Ctrl+Left Arrow Left one word

Ctrl+Right Arrow Right one word

Ctrl+Home To the top of the file

Ctrl+End To the bottom of the file

Edit Menu

The Edit menu is located in the Menu Bar at the top of the window. It contains a list
of edit commands for the currently selected system file.

To open the pull-down command menu, position the mouse cursor over the Edit
menu, and click the left mouse button.

A NetTune PRO command can be selected by pointing to the command and clicking
the left mouse button.

Undo

The Undo command is used to undo your most recent edit.

You can select the Undo command in two ways:

• From the Edit menu, choose Undo.

• From the keyboard, press Ctrl-Z.
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Cut

The Cut command deletes the highlighted text and pastes the text into the clipboard.
After cutting, you can paste the contents of the clipboard anywhere in a file.

You can select the Cut command in three ways:

• From the Edit menu, choose Cut.

• From the keyboard, press the Ctrl-X.

• From the toolbar, click on the Cut icon.

Copy

The Copy command copies the highlighted text to the clipboard. After copying, you
can then paste the clipboard contents anywhere in a file. Many NetTune PRO
Windows that contain graphs and text can be copied to the clipboard.

You can select the Copy command in three ways:

• From the Edit menu, choose Copy.

• From the keyboard, press the Ctrl-C.

• From the toolbar, click on the Copy icon.

Paste

The Paste command is used to paste text from the clipboard into one or more
locations in your file. You must position the cursor where you want the text to
appear.

You can select the Paste command in three ways:

• From the Edit menu, choose Paste.

• From the keyboard, press the Ctrl-V.

• From the toolbar, click on the Paste icon.
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Using Windows Help
NetTune PRO is equipped with a built-in Help utility that can help you use NetTune
PRO. The Help pull-down menu is located on the top right side of NetTune PRO’s
Menu Bar. You can also access the on-line help using the three toolbar icons. The
Help icons can be found on the right side of the Toolbar. These icons give you fast
access to either the Help Index or the Context Sensitive Help.

On-line Help Index

The on-line Help Index contains important information about the following NetTune
PRO information:

• On-line help manual

• Server statistics reference

• NetTune PRO menu descriptions

• McAfee information and technical support
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Help on Using Help

If you have not learned how to use Window’s Help, you can use the on-line help to
get information regarding any Help command. The Using Help command opens the
How to Use Help window.

NetTune PRO Advisor

The NetTune PRO Advisor is an on-line Help utility that is located on NetTune
PRO’s tool bar, or in the Help pull-down menu.

Context-Sensitive Help

NetTune PRO also includes context-sensitive help that allows you to quickly locate
information on specific topics. The context-sensitive help can be identified using the
Context Sensitive Help icon located on the right side of the Toolbar.

To get Context Sensitive Help on a specific topic:

1. Click on the Toolbar Context Sensitive Help icon.

2. From NetTune PRO’s Menu bar, click on any menu item. This brings up
context-sensitive help for that topic.
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Printing Help Topics
You can print Help topics in two ways:

• Using the NetTune PRO Help Utility

• Using the Context Sensitive Help icon

Printing Help Topics Using the NetTune PRO Help Utility

One way to print help topics is to use NetTune PRO’s Help utility.

1. From NetTune PRO’s Menu bar select Help.

2. Click on the Index command to open the NetTune PRO’s Help Index screen.

3. Position the mouse pointer over the topic you want to print.

Click the mouse button to display the Help topic.

NOTE:  The mouse pointer changes into a hand when the cursor passes over a
hypertext jump point.

4. Next, go to NetTune PRO’s Help menu bar and select File.

5. Finally, click on Print Topic to start printing the selected topic.

Printing Help Topics Using NetTune PRO

Help topics can also be printed by using the Context Sensitive Help icon located on
NetTune PRO’s Toolbar.

1. Select the Context Sensitive Help icon from the Toolbar by double clicking on
the icon with the mouse button.

NOTE:  The mouse cursor changes to an arrow in the shape of a question mark.

2. Use the question mark cursor to scan through NetTune PRO’s Menu bar. When
you see a menu topic of interest, double click the left mouse button to open the
Help screen.

3. After the Help screen appears, go to NetTune PRO’s Menu bar and select File.

4. Click on Print Topic to send the context-sensitive help information to the
printer.
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Chapter 4 Configuring NetTune PRO

Configuring Servers
You can check server configuration by pressing number 5 in the Quick Start Dialog
box during installation or after installation using the Server Configuration from the
Information pull-down menu.

From the Server Configuration dialog, select any server in the Servers selection box.
Detailed server configuration statistics and information becomes accessible for the
selected server. The data fields are updated every five seconds.

The following options are available:

• NetWare Information

• LAN Information

• Connection Information



Using NetTune PRO 39

• Volumes Information

• NLMs Loaded, Versions and Description Information

• SET Parameters Values

• Historical Information

Selecting Servers from the Desktop or Groups

Using the Server Configuration dialog box, you can view configuration information
for the selected specific file servers. The Servers selection box, located at the bottom
left of the Server Configuration dialog box, displays icons representing groups that
contain file servers.

NetTune PRO’s default group is called Desktop.

The Desktop group may contain a single file server or many file servers depending
on the following conditions:

• How many file servers have been loaded by the NetTune PRO NLM.

• How many of the loaded file servers have been added to the Desktop group.

Any file server(s) added to a group after the NLM installation displays an icon with
the file server name in a list tree for that group.

To view the list tree containing the server’s icon and name, double-click on the
group icon. The group expands into a list tree that displays all the file servers
associated with that particular group.

To close a list tree, double-click on the corresponding group icon.

Any additional groups you create also display in the Servers’ selection box.

Click on any group icon to expand the group’s internal tree and display a list of all
file servers associated with that group.
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Modifying the Default Recording Intervals
To take full advantage of NetTune PRO, you should set up the preferred historical
recording intervals before you install the NLM software. Once the NLM software is
installed and loaded, it immediately begins collecting data based on the NetTune
PRO default recording intervals defined at the time of install (see the following
table). You also can change recording intervals later by accessing the Recording
Intervals option under the Statistics pull-down menu.

Default Times for Recording Interval and Duration

Interval Duration

Real-Time 5 seconds 3 minutes

Short-Term 5 seconds 24 hours

Long-Term 5 minutes 90 days

If the supplied default values are not sufficient, change to time intervals and
durations that are more appropriate. The historical recording intervals use two
variables to allow NetTune PRO to collect and record data.

• Recording Interval:  defines how often NetTune PRO collects (or records)
data.

• Recording Duration:  specifies the maximum time the data is  kept.

Changing Recording Interval and Duration

To set preferred historical recording intervals:

1. Click on the number 2 button from the Quick Start dialog box to access and
modify the default preferred recording intervals.

2. In the Recording Intervals dialog box appears, specify the Recording Duration.
The recording duration defines the specific time period in which server data is
collected.

You also must specify a collection time called the Recording Interval. The
recording interval defines how often NetTune PRO’s NLM collects server data.
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Record Interval Database Files

The Maximum Size and Current Size fields (found in the Recording Interval dialog
box under Current Recording Interval for Selected Server) are the sizes of the
historical data base files. These files are created when a recording interval or
recording duration time is supplied for real-time, short-term, or long-term data
collection as shown in the following table.

Recording Interval Database File Names

Type of Statistical
Information

Recording Interval
File Name

Real-Time A temporary file in memory (RAM) that
contains the real-time statistics.

Short-Term
(NT$HIST0.NTD)

A file that contains short-term recording
interval information. When this file reaches
its maximum size (defined by the
Recording Duration), it purges the oldest
data in the file.

Long-Term
(NT$HIST1.NTD)

A file that contains long-term recording
interval information. When this file reaches
its maximum size (defined by the
Recording Duration), it purges the oldest
data in the file.

The Maximum Size field is shown in bytes. This field is based upon a pre-calculated
file size that is derived from the specified Recording Interval and Recording
Duration times. If you change the recording interval or recording duration time for



42 Using NetTune PRO

real-time, short-, or long-term data collecting, the maximum size field automatically
recalculates. A new allocated maximum size value for that collection period is then
displayed.

The Current Size field is shown in bytes. This field is the historical interval database
file’s current size. The current size field tells you how much disk space your current
historical database file is occupying.

Changing the Default Values

To change Recording Interval and Duration default values:

1. Use the scroll bars to scan the selection choices. Once the appropriate times are
established, click on the Set button to save your changes.

2. Click on the Close button when you are finished.

The following table shows the maximum and minimum times allowed when
selecting recording interval and recording duration times.

Maximum and Minimum Times for Recording
Interval and Duration

Interval Duration

Real Time 5-30 seconds 1-10 minutes

Short Term 5-30 seconds 1-48 hours

Long term 1-60 minutes 1-400 days

To return the recording intervals back to the default values:

1. Select the desired server from the Server list dialog box.

2. Click on the default command button, and click the Close button.
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Logging into and out of Servers
To modify data on a file server, you may be required to log in to gain console rights.
You also can log out of file servers and enable or disable logins to the file server.

Logging In

If you select the Login command from the Options menu, the Login dialog box
appears.

To modify data on a file server, you may be required to log in to gain console rights.

NOTE: If you get an “Invalid login!” message while attempting to log in, your ID
or password is invalid or no additional connections are available on the server.

To log in to a file server:

1. Select Login from the Options pull-down menu.

2. Enter an ID in the User ID text box.

3. Enter a password in the Password text box.

4. Click on the Login button.

NOTE: Re-logging into the same file server with a different login name may change
your access rights or drive mappings.
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Logging Out

If you select the Logout command from the Options menu, the Logout dialog box
appears.

The Logout dialog box is used to break the connection between the current
workstation and the file server.

To log out of a file server:

1. Select Logout from the Options pull-down menu.

2. Click on the Logout command button in the Logout dialog box.

Enabling and Disabling Logins

When the Login Status command is selected from the Options menu, the Login
Status dialog box appears.

This dialog box is used to enable or disable logins to the file server. If disabled,
users are unable to login to the server. The default for Login Status is Enabled.
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To disable logins:

1. Select Login Status from the Options pull-down menu.

2. Click on the Logins Enabled check box.

Click on the OK button for the action to take affect.

NOTE: Before exiting this dialog box, make sure you really want to disable logins
to the file server.

Taking Down the Server
It is necessary to occasionally take down a file server for maintenance. The Down
Server dialog box is used to gracefully take down a file server.

CAUTION: It is a good idea to schedule shutdowns. Downing a file server “cold”
guarantees damage to user files. This command should be executed only after all
users have logged off the server.

Always warn all users before you shut down a file server.

You must have Supervisor rights to take down a file server with the Down Server
command. After downing the server, NetTune PRO automatically hides the server
icon.

To display the server icon:

1. Select Group Maintenance from the Options pull-down menu.

2. Select the server and click on Show command button. If the server does not
show, then the NetTune PRO NLMs are not running or the server is down.
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Chapter 5  Tuning Your System

NetTune PRO’s SmartTune NLM is designed as an add-on module to enhance the
NetTune PRO software and provide a total solution for NetWare optimization.

This chapter explains the ways to modify a server’s SET parameters. The section on
scheduling Tune files also contains an example on how to modify SET parameters.

Using the Tune pull-down menu, you can modify a server’s SET parameters in three
ways:

• By manually adjusting internal NetWare operating system’s SET parameters
through NetTune PRO’s Graphical User Interface.

• By creating custom Tune files and scheduling parameter changes through those
custom Tune files.

• By have SmartTune automatically adjust the server(s) SET parameters on the
fly.

You can use any of these methods of controlling SET parameters; it’s completely up
to you.

Tuning Your System Automatically with SmartTune
You do not need prior experience with SET parameters to successfully use
SmartTune. SmartTune’s sophisticated artificial intelligence is able to automatically
adjust SET parameters on the fly, based on collected real-time data.

As SmartTune detects changes in real-time, it makes changes accordingly. The
resulting optimization helps eliminate bottlenecks or potential dangers associated
with configuring your operating system. The main advantage of the SmartTune
module is that it can be automatically optimizing your system while you carry on
with your other administration duties. You don’t have to worry about manually
adjusting parameters if you don’t want to.
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Using SmartTune Optimization Control

For those who prefer to have SmartTune handle all aspects of optimizing the
network server:

1. Select the Tune pull-down menu from NetTune PRO’s menu bar.

2. Select SmartTune from the Tune pull-down menu.

3. When the SmartTune dialog box appears, it displays the Tuning Options dialog
box. Select the file server you want to tune by clicking on the appropriate server,
located in the Servers selection box.

4. If the Tuning Options dialog box isn’t displayed, select Tuning Options from
the Options selection box.

5. Select Non-Specific from the Server Environment selection box.

6. If the SmartTune check box is not enabled, the Enable SmartTune (Automatic
Tuning) check box is empty.

7. Make sure SmartTune is enabled by clicking on the check box to place an X in
it. SmartTune will then make all modifications to a server’s SET parameters.

8. When this is done, click on the Set button to save your choices, then click on the
Close button to exit.

Disabling SmartTune

If you no longer want to have SmartTune automatically tune all aspects of the
selected server, remove the X from the Enable SmartTune (Automatic Tuning) check
box to disable SmartTune.
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Click on the Set button to save your change.

Using the SmartTune Tuning Options

SmartTune’s Tuning Options feature allows you to manage performance and
optimization on your server. Each of the four SmartTune dialog boxes has the same
look and feel.

Options Selection Box

The Options selection box, located at the top left of the SmartTune dialog box,
allows you to select four different options for SmartTune:

• Tuning Options

• Quick Analysis

• Activity Log

• Performance Indicators
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Servers Selection Box

The Servers selection box, located at the bottom left of the SmartTune dialog box,
allows you to select a preferred file server.

To select a file server:

1. Double click on the group icon to expand the Group list into the Server list.

2. Click on the desired server.

Printer Check Box

The Printer check box, located at the top right of the SmartTune dialog box, allows
you to select multiple options for printing.

Printing a report:

1. In the Options selection box, highlight the options you want to include in the
report.

2. Mark the Printer check box with an X by clicking on the left mouse button.

3. If you would like to include other options in the report, repeat the process from
Step 1. To deselect options, highlight the option and click in the Printer check
box to remove the X.

4. Once you have highlighted all the options you want to print, click on the Report
button at the bottom of the SmartTune dialog box to print the report to either a
printer or an ASCII text file.

5. When you click on the Report button, the SmartTune Report topics window
appears.
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6. Use the mouse to place an X next to the report topics you want to print. All of
the options you have highlighted for printing under the selected topics will be
printed. You can use the Select All or Deselect All buttons to quickly add or
remove topics.

7. Under Output, select a destination for the report. You can output the report to a
printer or to an ASCII text file.

• If you are sending the report to the printer, you can check the printer’s setup
using the Print Setup button. (See Setting Up Printers in this chapter for
more information on working with the Print Setup dialog box.) Otherwise,
click the OK button and the report will print.

• If you send the report to a file, after you click the OK button, a dialog box
appears asking you for a filename. If you want to send your report to a file
that already exists, you can choose to append the new report to the old file
(rather than overwrite the old file) by placing an X in the Append to
Existing File check box.
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Tuning Options Window

SmartTune automatically adjusts SET parameters on the fly. The adjustments are
based on complex decisions made by the software’s artificial intelligence from data
that is collected every second.

The SmartTune Tuning Options dialog box has a Tuning Options window.

To use the Tuning Options window, select the desired server from the Servers
selection box.

In the Tuning Options window, you see a Server Environment selection box and a
number of server check boxes.

The Server Environment selection box contains the following environments:

• Non-Specific

• Backup

• Database

• Word Processing

• Read Intensive

• Write Intensive

• Software Development

Select the environment that best suits your network environment. Once the desired
environment has been established, you need to mark the Enable SmartTune
(Automatic Tuning) check box to ON. Click the check box, which places an X in the
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check box and enables SmartTune. Then click on the Set button to save your choices
and click on the Close button to exit.

In some cases, you may not want SmartTune to adjust all the SET parameters for
your specific environment. In this case, you should click on the Enable SmartTune
(Automatic Tuning) to activate SmartTune. Next, click on the check boxes that best
identify the areas that need SET parameter modification.

Following is a list of the additional check boxes:

• Optimize File Cache

• Optimize Disk I/O

• Optimize Directory Cache

• Optimize Turbo FAT

• Optimize Packet Receive Buffers

• Optimize Service Processes

You can select as many of these fields as you want as long as you click on the
Enable SmartTune (Automatic Tuning) check box. Smart Tuning does not take place
if the check box is not activated.

If you want SmartTune to handle all aspects of optimizing the network server, select
Non-Specific in the Server Environment, and click on the Enable SmartTune
(Automatic Tuning) check box. Then click on the Set button to save the choices and
the Close button to exit.

If you no longer want to have SmartTune tune the selected server, click on the
Enable SmartTune (Automatic Tuning) check box to remove the X from the check
box and disable SmartTune.

Click on Set to save your settings.

The SmartTune Tuning Options dialog box includes the following push buttons.

Button Description

Set The Set button saves your SmartTune
choices.

Refresh The Refresh button refreshes the CRT
screen display.

Report The Report button prints out a report of
all previously selected categories.



Using NetTune PRO 53

Help The Help button brings up NetTune
PRO’s Help Index.

Close The Close button ends the session and
quit.

Using SmartTune Quick Analysis

The Quick Analysis dialog box  provides information and recommendations about
the selected file server. The Quick Analysis window has three fields: the Show
selection box, the Results and Recommendations dialog box, and the Background
dialog box.

The Show selection box includes three radio buttons. The radio button you select
determines the information that is displayed in the Results and Recommendations
and Background dialog boxes.

SmartTune’s Quick Analysis runs two sets of pass/fail diagnostics on the server’s
SET parameters. The parameters either pass or fail.

SmartTune’s Show selection box defaults to Recommendations Only. This display
shows the results of all of the diagnostics that have failed. These results (and their
recommendations) are displayed in the Results and Recommendations dialog box.
The Background dialog box includes a brief description of the recommendation.

The Succeeded Only radio button displays only the diagnostics that passed the
diagnostic test. The Results and Recommendations dialog box lists all the server’s
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SET parameters that are okay. The Background dialog box also displays a brief
description of why these SET parameters are okay.

If you choose to see all the results (pass or fail), select the All Results radio button.
All the successes and failures found with the selected server’s SET parameters are
displayed. The Background dialog box also displays a brief description of why these
SET parameters are good or bad.

The SmartTune Quick Analysis dialog box includes the following push buttons.

Button Description

Accept The Accept button accepts any recommendations for
diagnostics that have failed.

Refresh The Refresh button reruns the diagnostics and
refresh the display.

Report The Report button prints out all previously selected
categories.

Help The Help button brings up NetTune PRO’s Help
Index.

Close The Close button quits your session and exit.

Using the SmartTune Activity Log

The SmartTune Activity Log provides a comprehensive log file of all NetWare
activity that occurred while the SmartTune NLM was loaded.



Using NetTune PRO 55

This information collected from the server is stored in an activity log file called
NT$LOG.NTD. This file is stored in the SYSTEM directory on the server’s SYS
volume.

The SmartTune Activity dialog box includes the following push buttons.

Button Description

Clear The Clear button clears out the activity log.

Refresh The Refresh button refreshes the screen’s
display.

Report The Report prints out all previously selected
categories.

Help The Help button brings up NetTune PRO’s Help
Index.

Close The Close button ends your session and exit.

Using the SmartTune Performance Indicators

The Performance Indicators option (located in the Options selection box) displays
the real-time server activity that most affects NetWare performance.

From this dialog box, you can select your preferred file server from the Servers
selection box, located at the bottom left of the screen.

Performance Indicators Window

Once the preferred server is selected, the performance indicators begin displaying
the percentage of real-time activity for the following categories:
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• Server Utilization

• Dirty Cache Buffers

• Current Disk Requests

• Service Processes

• Packet Receive Buffers

• Directory Cache Buffers

• Percent of Volume Purgeable

• Connections in Use

• Cache Hit Ratio

• Read\Write Ratio

The Performance Indicators display in three different colors:

Button Description

Red Indicates SET parameters require
investigation or possible action.

Green Indicates everything is OK.

Yellow Indicates SET parameters may require
investigation but do not require any
action.

The SmartTune Performance Indicators dialog box includes the following push
buttons:

Button Description

Refresh Updates the CRT screen with current
output data.

Report Prints all of the previously selected
categories.

Help Opens the NetTune PRO Help index.

Close Ends your session and exits.
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Tuning Your System Manually
The SET Parameters command is used to modify SET parameters or to create
custom Tune files that contain SET parameter modifications. Modifications are
made through the SET Parameters dialog box.

Many parameters can be adjusted in the SET Parameters dialog boxes. The different
parameters are described in Appendix B.

The SET Parameters command allows you to modify SET parameters for the
following NetWare categories:

1. Communication

2. Memory

3. File caching

4. Directory caching

5. File system

6. Locks

7. Transaction tracking

8. Disk

9. Time synchronization

10. NCP

11. Miscellaneous
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12. Error handling

13. Directory services

In addition to modifying SET parameters, you can also create custom Tune files.
Tune files contain modified SET parameters for a file server. You can schedule Tune
files to change a server’s SET parameters at a specified time. You can also export
SET parameters from one server or Tune file to other servers or Tune files.

The choices available for modifying SET parameters, creating Tune files, or
exporting SET parameters are available through NetTune PRO’s SET Parameter
dialog boxes.

Modifying SET Parameters  Manually
To modify SET parameters:

1. Click on Tune pull-down menu from NetTune PRO’s menu bar.

2. Select SET Parameters from the Tune pull-down menu.

3. When the SET Parameters dialog box appears, select the category that contains
the SET parameters you want to modify from the Categories selection box.

4. Make the change to the SET parameter by scrolling through the selections with
the up and down arrows, or type the desired value into the text window.

5. Click on the Set button to save those parameter changes to the Server’s memory
or NCF files. The SET Parameters Function Successful dialog box appears.
Click on the OK button.

6. When you are done modifying SET parameters, click on the Close button to
exit.

Working with the SET Parameter Dialog Boxes

There is a SET Parameter dialog box for each NetWare category found in the
Categories selection box. Each SET Parameter dialog box is similar in design. Some
of the SET Parameter dialog boxes have an asterisk (*) before the SET parameter
command. This asterisk indicates that the change is made to either the server’s
AUTOEXEC.NCF or STARTUP.NCF files. If there is no asterisk before the SET
parameter command, then the SET parameter change is made directly to the server’s
memory.

Some NetWare categories contain multiple pages of SET parameters. You can used
the Previous Page and Next Page buttons on the right-hand corner of the screen to
page back and forth through these dialog boxes.
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NOTE:  Because the SET parameters are different for each version, the pages for
NetWare 3.11, 3.12, and 4.10 servers are different.

At the top left of the SET Parameter dialog box is the Categories selection box. Here
you select the category of NetWare SET parameters you want to modify.

At the lower left of the SET Parameters dialog box is the Servers\Tune Files
selection box which allows you to select a server (or Tune file) for modification.

NOTE:  Only servers running the SmartTune NLM are displayed in the
Servers\Tune Files selection box

To view the Tune files that belong to a particular server, double-click on the file
server name. This expands the server list to show a Tune file list that contains all of
the Tune files associated with the selected file server.

At the bottom left of the SET Parameter dialog box is the Information selection box
which contains the following information:
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• The NetWare version

• The NetWare user limit

• NetTune PRO version

• NetTune PRO Read\Write status

The Read\Write status of NetTune PRO should be noted. If SMARTUNE.NLM is not
loaded in write mode, you cannot alter any SET parameters or Tune files.

NOTE: Because, there are different pages for the SET parameters for NetWare 3.11,
3.12, and 4.10 servers, if you are modifying multiple servers that are running
different versions of NetWare, you will not see the same number of SET parameters
in the SET Parameters dialog boxes.

The SmartTune SET Parameters dialog boxes includes the following push buttons:

Button Description

New The New button creates a new Tune file that contains either
newly modified SET parameters or Novell’s default SET
parameters.

Export The Export button exports SET parameters from one server, or
Tune file, to other servers or Tune files.

Set The Set button saves any changes you make to the SET
parameters for the currently selected file server or Tune file.

Undo The Undo button removes any changes you made to the
current SET Parameters dialog box.

Default The Default button displays the NetWare default values for the
currently selected file server or Tune file.

Help The Help button brings up the NetTune PRO Help index.

Close The Close button ends your session and exits.
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The SET Parameters Dialog Boxes

The SET Parameters dialog boxes group the SET parameters by type. For specific
information about the individual SET parameters, please refer to Appendix B.
Appendix B lists the SET parameters alphabetically and includes descriptions and
information about default values, range limits, and applicable NetWare version(s).

NOTE: The list of SET parameters you see in the SET Parameters dialog boxes
depends on the version of NetWare that is being run on the selected server.

Communications

The Communication SET Parameters dialog box controls the communication buffer
settings. Several parameters can be adjusted in the Communications dialog box.

Watchdog Parameters

Watchdog parameters are used to make sure workstations are currently connected.

If the server has not received a packet from a workstation in a certain time (set by the
Delay Before First Watchdog parameter), a watchdog packet is sent to the station.

If the station does not respond within a certain time (set by the Delay Between
Watchdog parameter), another watchdog packet is sent.

If the station still does not respond to a certain number of watchdog packets
(determined by the Number of Watchdog Packets parameter), the server assumes
that the station is no longer connected and clears the station’s connection.

Packet Receive Buffer Parameters

Areas in the file server’s memory are set aside to hold data packets. These packets
remain in the buffers while being processed by the file server.

Memory

The Memory SET Parameters dialog box is used to control the size of the dynamic
memory pool, the block size of cache buffers, and the automatic registering of
memory on EISA bus computers.
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File Caching

The File Caching SET parameters allow faster access to frequently used files by
holding a file (or a portion of it) in memory. Files being read from or written to are
kept in file cache buffers.

The number of files kept in memory depends on the number of file cache buffers
allowed. This is determined by the amount of memory available and the Minimum
File Cache Buffers parameter.

Directory Caching

The Directory Caching SET Parameters dialog box is used to set directory cache
buffer parameters. Directory caching facilitates fast access to frequently used
directories. A directory entry stays in a cache buffer as long as it is being frequently
accessed. If used infrequently, the operating system overwrites the entry.

There is a trade-off between directory and file caching. When the number of
directory cache buffers is increased, the number of file cache buffers decreases.
Directory and file caching requirements must be carefully balanced for maximum
system performance.

File System

The File System SET Parameters dialog box controls the following functions:

• Maximum settings for files and directories

• Volume low warnings

• File purging

• Wait times

• File compression

• Turbo FAT reuse

Locks

The File Lock SET Parameters dialog box controls the number of:

• Open files each workstation can have

• Open files the system can handle

• Record locks each connection can have

• Record locks the system can handle
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These parameters control three types of locks:

• File

• Physical Record

• Logical Record

File Lock

This type of lock secures the entire file and prevents other stations from accessing
the file.

Physical Record Lock

This type of lock controls data access by multiple users. Physical Record Locks
prevent other users from altering a file. The system enforces this lock.

Logical Record Lock

This lock type controls data access by multiple users. Logical Record Locks prevent
users from altering certain sections of data in a file. The application enforces this
lock.

Transaction Tracking

The Transaction Tracking SET Parameters dialog box is used to change SET
parameters that control the Transaction Tracking System (TTS). A transaction is a
set of write operations that must be completed.

The Transaction Tracking System guarantees that a set of write operations will either
be written to disk in complete form, or backed out if incomplete. TTS ensures
database integrity in the event that the workstation, file server, or LAN fails before a
transaction has been completed.

Normally, it will not be necessary to change most of these parameters.

Disk

The Disk SET Parameters dialog box controls one part of Hot Fix redirection which
can occur during a write request, read request, or a read-after-write verification.

Write Request Hot Fix Redirection

This hot fix occurs when the disk reports an error during a write request. The
operating system marks the block as bad, and then redirects the data to a different
block.
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Read Request Hot Fix Redirection

This hot fix occurs when a disk error takes place during a read request. If the hard
disk is mirrored, the operating system retrieves the data from the mirrored disk, and
then redirects the data on the primary disk. If the hard disk is not mirrored the data is
lost, but the block is marked as bad so that future data will not be stored there.

Read After-Write-Verification Hot Fix Redirection

This hot fix occurs after the data is written to disk. The data on disk is then read and
compared to that in the memory. If the two do not match, the operating system
marks the block as bad, and redirects the data to a different block.

Time Synchronization Parameters

The Time Synchronization parameters control time synchronization, the
TIMESYNC.CFG file, and time zone settings to insure that the time reported by all
servers is consistent, or synchronized.

NCP Parameters

The NCP Parameters SET Parameters dialog box controls the NetWare Core
ProtocolTM  (NCP) parameters. Using these parameters, you can:

• Control NCPTM  packets

• Control boundary checking

• Assign the NCP Server Packet Signature levels

Miscellaneous Parameters

The Miscellaneous SET Parameters dialog box contains parameters for various alert
settings and other miscellaneous parameters.

Error Handling Parameters

The parameters in the Error Handling SET Parameters dialog box can be used to
control the size of error logs and what happens when logs exceed the specified size.
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Directory Services Parameters

NetWare Directory Services (NDS) SET Parameters dialog box contains parameters
that allow you to do the following:

• Control the NDS trace file.

• Set time intervals for maintenance processes that reclaim disk space, remove
external references, and check the consistency of backlinks.

• Set NDS synchronization intervals and restrictions.

• Specify the number of NCP retries before timeout.

• Mark the status of other servers in the namebase as UP or DOWN.

• Specify bindery services contexts.

Modifying SET Parameters Using Tune Files
SmartTune can schedule pre-defined files, called Tune files, to run unattended at
specific times. These Tune files contain the SET parameter changes for the file
server’s configuration, and they are identified by an .NTT extension.

The process of scheduling Tune files is called, Time Tuning. Through the SET
Parameters dialog boxes, the administrator can modify any SET parameters in a
Tune file, then schedule these parameter changes to automatically run on the server
at a specific time.

This feature allows you to tailor server operation to a specific requirement, such as
evening backup, or database manipulation during the day. The Tune files are created
and stored in the server’s SYS:SYSTEM directory, and are used by the
SMARTUNE.NLM file.

When creating a Tune file, use the custom-graphed historical data to determine
which SET parameters you should alter for maximum optimization.

By maintaining a history of server information during the day, you can chart file
server utilization. You can then identify the times when the server is handling heavy
traffic or when it is hardly being utilized. Once you have identified the utilization
times, you can start to change the SET parameters for performance optimization.
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Creating a New Tune File

To create a new Tune file:

1. Select SET Parameters from the Tune pull-down menu.

2. When the SET Parameters dialog box appears, click on the New button to open
the New Tune File dialog box.

3. If you choose to use NetWare’s defaults, then click on the NetWare Defaults
Values button. If you choose to use values that is modified by you, then select
the Server’s Current Values button.

4. Enter a Tune file name into the Name field. Give the Tune file a descriptive
name and a .NTT file extension. This extension enables NetTune PRO to
identify the file as a Tune file.

5. After you have entered a name, click on the OK button.

6. Click on the NetWare category that contains the SET parameters you want to
modify.

7. When the selected NetWare category dialog box appears, modify the SET
parameters as needed. When you’re finished, click on the Set button to save
those modifications to your new Tune file.

8. If you want to modify additional SET parameters from other NetWare
categories, and save them to your new Tune file, continue from Step 6.

NOTE:  If you forget to save any of the modified SET parameters, a dialog box
appears asking if you want to save your changes. You must decide before you
can alter any other SET parameter categories.

9. When you have finished modifying all the SET parameters, click on the Set
button to save any additional changes. Click on the Close button to end your
session.
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Using the Time Tune Command

The Time Tune command is used to create, schedule, or disable Tune Jobs through
the Time Tune dialog box. A Tune Job is the scheduling or unscheduling of a Tune
file.

NetTune PRO can schedule predefined files called Tune files to run unattended at
specific times. These files contain unique SET parameters for changing the file
server configuration. Tune files must have a .NTT file extension and must be located
in the SYSTEM directory of the SYS: volume.

The Time Tune dialog box consists of the following components:

Time Tune Job List Window

The Time Tune Job List window displays information on all existing Time Tune
files that will run on the server. It displays the following components: Tune file’s job
name, status (if it’s disabled or not), frequency rate (if the job runs daily, weekly, or
monthly), the time the Tune job begins running, and the Tune file name.

Servers Selection Box

The Servers selection box allows you to select the file server that contains the Tune
file(s) you want to schedule as Tune jobs. Click on the group icon to display and
select from the server list.

Tune Files Selection Box

The Tune Files selection box  is used to select the Tune files you want to schedule as
Tune jobs. Once you have selected the appropriate server, you see a list of that
server’s Tune files. Specific files can be selected using the mouse.
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Job Disable Check Box

This check box is used to temporarily enable or disable a Tune file. To disable a job
from running, place an X in the check box.

Job Name Text Box

Enter up to 16 characters in this box to name a Tune job.

Frequency Radio Button

The Frequency radio button is used to select the Tune job’s frequency (when the
Tune job will run). SmartTune can schedule Tune jobs on a daily, weekly, or
monthly frequency rate.

To select a frequency,  click on the appropriate radio button. If you select Daily, you
are able to adjust the hours, minutes, and seconds. The Day of Month selection box
and the Day of Week selection box are not selectable. The table below shows the
active selection boxes for each of the three frequencies.

Radio Button Active Selection Box

Daily Hours, Minutes, and Seconds

Weekly Day of Week, Hours, Minutes, and
Seconds

Monthly Day of Month, Hours, Minutes, and
Seconds

Day of Week Pull-Down Selection Box

When the Weekly frequency radio button is selected, the Day of Week selection box
becomes active. Click on the down arrow to see your choices. A pull-down list
appears with all seven days of the week. Select the appropriate day you want to
activate your Tune job.

Day of Month Selection Box

When the Monthly frequency radio button is selected, the Day of Month selection
box becomes active. Click on the up and down arrows to see your choices. Select the
appropriate day of the month you want to activate your Tune job.

Time Selection Box

Whenever the Daily, Weekly, or Monthly frequency radio button is selected, the
Time selection box becomes active. You can click on the up and down arrow to see
your choices. Select the appropriate hour, minute, and second of the day you want to
activate your Tune job.
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The SmartTune Activity dialog box includes the following push buttons:

Button Description

Delete The Delete button is used to delete the
highlighted Tune job in the job list.

Save The Save button saves the current Tune file
schedule

Help The Help button brings up NetTune PRO’s Help
index.

Close The Close button ends the session without
saving any changes.

Running a Sample Tune File

Understanding how a Tune file is created helps to demonstrate its ease of use.

For example, backing up data on the LAN is a critical task. Administrators are often
looking for ways to enhance backup throughput. This example focuses on the issue
of increased backup performance.

The following tuning example can be used on file servers to increase backup
performance. The example assumes that the nightly backup begins at 11:01 p.m. and
completes at 5:55 a.m. Additionally, the current server’s SET parameters are the
NetWare defaults.

In the first step of the Tune file example, you create two Tune files:

• BACKUP.NTT - This file contains the modified SET parameter changes that
increase backup throughput. It is scheduled to run before your backup begins
and automatically adjusts the SET parameters, causing faster backup
throughput.

• RESET.NTT - This file contains the default NetWare SET parameters. It is used
to set the selected file server back to its default configuration after the backup
completes.

In the second step of the Tune file example, you schedule a Tune job. Tune jobs are
the scheduled run times for the Tune files (BACKUP.NTT and RESET.NTT).

IMPORTANT:  Have your tape Backup software create a log file that contains
information on the amount of data that was backed up, and the elapsed time during
backup. This log file gives you a comparison benchmark for the backup performance
improvement after the parameters have been optimized.
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In the third step of the tune example, you run two backups. The first backup is run at
night without any changes to the server. This backup is run to log the elapsed time
for the backup without NetTune PRO. The following night, you run your backup
using NetTune PRO, BACKUP.NTT and RESET.NTT. In the morning, you can
compare both elapsed times from the LOG files to check the improvement in backup
time.

Creating the Tune Files

1. Click on the Tune pull-down menu from the NetTune PRO menu bar.

2. Select SET Parameters from the Tune pull-down menu.

3. When the SET Parameters dialog box appears, click on the New button, which
creates a new Tune file.

4. The New Tune File dialog box appears. Select the Server’s Current Values radio
button.

5. For the Name field enter BACKUP.NTT.

6. Click on the OK button.

7. The new Tune file is listed in the Servers\Tune Files selection box on the lower
left of SET Parameters dialog box. Select BACKUP.NTT by highlighting the
Tune file name.

8. While the Tune file BACKUP.NTT is highlighted, click on File Caching from
the Categories selection box.

9. When the File Caching dialog box appears, change the parameter Dirty Disk
Cache Delay Time to 5.0 seconds.

10. Next, change the parameter Maximum Concurrent Disk Cache Writes to 25.

NOTE:  Changing this parameter has no adverse effect on your file server.
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11. Click on the Set button to save your changes to the File Caching category. The
SET Parameters Function Successful dialog box appears. Click on the OK
button.

12. Select Directory Caching from the Categories selection box.

13. When the Directory Caching Parameter dialog box appears, change Dirty
Directory Cache Delay Time to 7.0 seconds.

14. Click on the Set button to save your changes to the Directory Caching category.
The SET Parameters Function Successful dialog box appears. Click on the OK
button.

15. Select File System from the Categories selection box.

16. When the File System Parameters dialog box appears, click NCP File Commit
to OFF (the box should be empty).

NOTE:  Turning this function off frees up processor time so the server doesn’t
have to look for NCP files to flush. Changing this parameter has no adverse
effect on your file server.

17. Click Immediate Purge Of Deleted Files box to ON (the box should now have
an X in it).

WARNING:  Turning this parameter on decreases read time because all deleted
files are purged without delay. Be aware that when a deleted file is purged, it
can never be restored again. If you feel you may need to salvage a deleted file
do not use this command.

18. Click on the Set button to save your changes to the Directory Caching category.
The SET Parameters Function Successful dialog box appears. Click on the OK
button.

19. Select Disk from the Categories selection box.

20. The Disk Parameters dialog box now appears. Turn Enable Disk Read After
Write Verify to OFF.

WARNING:  If you’re not sure whether your server drive includes hardware-
level read-after-verify, consult your disk manufacturer before changing this
parameter.

21. Click on the Set button to save your changes to the Disk category. The SET
Parameters Function Successful dialog box appears. Click on the OK button.

22. You need to create another Tune file that resets the servers SET parameters back
to the original NetWare defaults. To do this we need to click on the New button.

23. The New Tune File dialog box appears. Make sure your radio button selection is
for NetWare Default Values.
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24. For the Name field, enter RESET.NTT.

25. Click on the OK button.

26. The new Tune file is listed in the Servers/Tune Files selection box on the lower
left of the screen. Click on the Close button.

You now have two Tune files:

• BACKUP.NTT, which contains the six modified SET parameters.

• RESET.NTT, which contains the default values for NetWare.

Scheduling the Tune Files

You have created the two Tune files for the tune example. The second step is to
schedule a time for the Tune files to run. A scheduled job is called a Tune Job.
Scheduling a Tune Job is called Time Tuning.

1. Click on the Tune pull-down menu from NetTune PRO’s menu bar.

2. Select the Time Tune command from the Tune pull-down menu.

3. The Time Tune dialog box appears. You need to create two Tune Jobs for each
Tune file. First select a file server for tuning from the Server(s) selection box.
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4. Select the BACKUP.NTT Tune file from the Tune Files selection box by
highlighting the Tune file’s name.

5. Schedule the BACKUP.NTT Tune job to run:

• For Job Name, type in BACKUP.

• For Frequency, choose Daily.

• Set Hour to 23.

• Set Minute to 0. (This schedules BACKUP.NTT to run at 11:00 p.m.)

6. Click the Save button to save the Time Tune Job.

NOTE:  Remember, your example backup starts at 11:01 p.m. If your backup
takes place at a different time, schedule BACKUP.NTT to run one minute
before your backup begins.

You now see the BACKUP.NTT scheduled as a Tune Job, and listed in the
Time Tune Job List window

7. Repeat this process for RESET.NTT by clicking on the New button.

8. Schedule the RESET.NTT Tune job to run:
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• For Job Name, type in RESET.

• For Frequency, choose Daily.

• Set Hour to 6.

• Set Minute to 0. (This schedules RESET.NTT to run at 6:00 a.m.)

9. Click the Save button to save the Time Tune Job.

NOTE:  Remember that our example backup ends at 5:55 a.m. If your backup
finishes at a different time, then schedule RESET.NTT to run five minutes after
your backup completes.

10. You now see the RESET.NTT scheduled as a Tune Job, and listed in the Time
Tune Job List window.

11. The Tune files are now scheduled to run. Click on the Close button to exit.

• 12. The last step of our Tune File example requires that you run two
backups: One night, run a backup without Time Tuning.

• The following night, run a backup with Time Tuning.

Remember to check your tape backup LOG file for the time comparison.

You can also disable a Tune Job by placing an X in the Job Disable check box when
the Tune file is highlighted. If you want to delete a Tune file, highlight the Tune file
and press the Delete button. Doing so deletes the file permanently.

Exporting SET Parameters

To a Server or Tune File

The Export function copies all SET parameters from a source, either a file server or
Tune file, to multiple destinations that are other file servers or Tune files. This
feature allows you to create a duplicate set of SET parameters for another server or
Tune file without selecting each SET parameter individually.
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NOTE:  The Export function does not copy Tune files to other destinations. It
copies the SET parameters from a source to multiple destinations (i.e., other Tune
files or servers).

To Another Server

To export a file server’s SET parameters to another file server:

1. You can select a file server from a group icon listed in the Source selection box
by double clicking on the group icon. The group icon expands into the server
list.

2. When the source server list appears, click on the file server that contains the
values you want to export. The Source: SET parameters Name and Current
Value window now displays the current SET parameters for the selected server.
You can view all the SET parameters for that server by scrolling through the
Source: SET parameters Name and Current Value window.

3. When you are satisfied that these source values are the ones you want to use,
double-click the group icon from the Destination window that contains the
destination server.

4. When the destination server list appears, click on the server(s) you want to
receive these SET parameters.
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5. When you have selected the destination server(s), click on the Export button.
This exports the source SET parameters to the destination server’s NCF file(s).

6. Click on the Close button to end your session.

Exporting Tune Files
Exporting a Tune file to multiple file servers (or other Tune files) works almost like
exporting SET parameters to another server. While the server list is displaying,
double click on the sever list to expand the list and display the Tune file list for both
source and destination. Click on all destination servers or Tune files that you want to
receive the exported SET parameters.
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Chapter 6 Viewing and Reporting

NetTune PRO allows you to monitor vital statistics to locate trends and track usage
and resources on the network. You can use functions found under the Information
and Statistics pull-down menus to monitor important configuration and statistical
data.

Viewing Network Information
You can view and print information using the Information menu. This menu
provides the following data:

• File server configuration

• NLMs loaded

• Current SET parameter values

• Connections summary

Viewing Server Configuration

The following information is found under the Server Configuration command from
the Information pull-down menu.

• NetWare Information

• LAN Information

• Connection Information

• Volume Information

• NLM Information

• SET parameters range information

• NetTune PRO information
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Select a file server and then select the appropriate option from the information pull-
down to see the dialog box.

Each screen shows information for the selected file server. The following is an
example of the LAN Information screen.
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Viewing NLMs Loaded

The following information is found under the NLMs Loaded command from the
Information pull-down menu The NLMs Loaded command provides the following
specific NLM information:

• Name

• Code size

• Data size

• Total size

• Version

• Date

• Description

Checking SET Parameter Values

The SET Parameters Values command from the Information pull-down menu reports
the following SET parameter information:

• SET parameter name

• Current value

• SET parameter range

Viewing the Connections Summary

The Connections Summary command is used to display or print a report containing
the following Connection information:

• Connection number

• Login name

• Number of minutes connected

• Total NCP requests

• Total bytes read

• Total bytes written

• Network address
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Viewing Statistics
The Statistics menu provides pre-defined graphs and reports on all aspects of
NetWare statistics. You can use the default graphs and reports as is, customize them,
or create new graphs and reports. Recording intervals and durations can be adjusted
to control the frequency and time frame of collected data.

Graphs and charts display file server activity over a specified period of time. Any
graph can be changed to another style (2D, 3D, Pie, Line, etc.) by selecting the
Graphs Option icon from the Toolbar menu, or by selecting the Customize
command from the Statistics’ pull-down menu.

You can view the following statistical information:

• Network Statistics: The graph shows the amount of packet activity over the
network for a specific period of time. Network activity is displayed in three
statistics:

• Packets Received

• Packets Transmitted

• Packets Routed

• Disk Statistics: The graph shows the amount of disk activity for a specific
period of time. Disk activity is displayed in three statistics:

• Disk Reads

• Disk Writes

• Disk Requests
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• Connection Statistics: The graph shows the number of users connected to the
server for a specific period of time. Connection activity is for the connected
stations.

• Utilization Statistics: The graph shows the percentage of CPU utilization on the
server for a specific period of time. Higher percentages indicate a busy server.

• Volume Statistics: The graph displays the volume size in bytes. The Volume
Statistics are broken down into four parts:

• Used

• Available

• Purgeable

• Not Yet Purgeable

• LAN Segment Statistics: The graph displays the amount of packet activity (in
number of packets) on each LAN segment for a specific period of time. LAN
Segment activity is broken down into Total Packet for a LAN Adapter. The
representation of Total Packets for a LAN Adapter depends on the number of
LAN adapters installed in the file server. Each LAN adapter is represented by a
different color in the Legend.

• Memory Statistics: The graph displays the memory usage and allocation for a
specific period of time. The Memory Statistics are displayed in five parts:

• Cache memory

• Permanent memory

• Allocated memory

• Movable memory

• Non-movable memory

• Free Space Statistics: The graph displays the number of free bytes in a volume
for a specific period of time. Each color on the Graph represents a volume on
that server.

• Read Ratio Statistics: The graph displays an approximate Cache Hit Ratio over
a specific period of time. The Read Ratio statistics are broken down into two
parts:

• Disk Reads

• File Reads
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• Cache Buffers Statistics: The graph displays the Cache Buffer Statistics for a
specific period of time. The Cache Buffer statistics are displayed in four parts:

• Current Cache Buffers

• Directory Cache Buffers

• Receive Cache Buffers

• Dirty Cache Buffers

Viewing Statistics in a Graph

To view actual statistics in a graph:

1. Click on the Hot Key icon. The cursor changes into a thick vertical arrow.

2. Place the arrow cursor over the desired color segment.

3. Click and hold down the left mouse button. This displays the actual numbers for
that region of the graph.

Viewing Statistics in a Text Report

Graph data can be displayed as an ASCII text report.

To view an ASCII text report:

Click on the Graph/Text icon. This changes the Network Statistics graph into a
readable (and printable) text report.

Creating Custom Reports
NetTune PRO enables you to create custom report/graphs from predefined reports.
After opening one of the Statistics menu predefined statistical reports, the Customize
command is used to modify and create a new report/graph.

After you create a new report/graph, you can name it, save it, and use it to run the
report later.

To create a custom report:

1. First, select a predefined report to modify.

2. Next, select the Statistics pull-down menu and choose the Customize command.

3. The Customize Reporting dialog box appears. This dialog box contains many
options for customizing reports to your specific requirements.
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Using the Customize Reporting Dialog Box

This section contains a functional description of the check boxes, list boxes, and
command push buttons found in the Customize Reporting dialog box.

Report Type Option Buttons

These buttons represent a group of mutually exclusive report options. You can select
only one option at a time.

Button Description

Real-Time Create a report and update in real-
time.

Short-Term History Use the short-term history
database.

Long-Term History Use the long-term history database.
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Previous Check Box

This check box is used to view recorded data for the previous time period specified
in the Time Range boxes. This option is not available for Real-time Report Type.

Range Option Buttons

These buttons represent a group of mutually exclusive report range options. The
selected option is used to determine the range of historical data to be displayed. You
can select only one option at a time. The selected radio button contains a black dot.

Button Description

Day Display server data for the last full day.

Week Display server data for the last seven days.

Month Display server data for the last month.

Quarter Display server data for the last three months.

All Display all daily server data.

If you select one of these options, the start and end date times are automatically
adjusted. You can then manipulate the start and end dates manually.

Output Option Buttons

These buttons represent a group of mutually exclusive report output form and
destination options. You can select only one option at a time. The selected options
button contains a black dot.

Button Description

Comma Delimited File Outputs the server collected historical
data to a comma delimited ASCII.

ASCII Text File Outputs the server collected historical
data to an ASCII file.

Text Screen\Print Outputs the server collected historical
data as a text report to the screen or
printer.

Graph Screen\Print Outputs the server collected historical
data as a graph report to the screen or
printer.
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Time Range Selection Boxes

These selection boxes are used to determine the beginning and ending time ranges of
displayed historical data.

To avoid plotting incorrect data, time ranges must not exceed the start and finish
dates for Long-Term and Short-Term History database files.

Time range parameters can be used to display a desired interval of data from the
database.

Display Interval Selection Boxes

These selection boxes are used to determine the time interval at which data is
sampled.

Statistical Classes List Box

This box displays a list of statistical class choices. Use the Statistical Classes list box
to select network categories for creating graphs and custom reports.

Statistical Classes are the areas of NetWare interest and include Cache, Connections,
Utilization, Disk Activity, FAT, Memory Pools, and Processor.

To select all Class Data Items associated with the current selection, click on the Add
All command push button.

Class Data Items List Box

This box displays the Class Data Items associated with the selected Statistical Class
topic.

To select individual Class Data Items, click on your choices. To add your selections
to the graph or report, click on the Add button.

If you would like your graph to include all Class Data Items in the list box, click on
the Add All button.

If you select Disk Total for the Statistical Class, it shows you Disk Read and Disk
Write totals for the data items in that Statistical Class.
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Selected Data List Box

This box displays the Class Data Items you selected for your custom graph or report.

To remove Class Data Items, click on your choices, and then click on the Remove
command push button.

The Customize Reporting dialog box also contains the following command push
buttons:

Button Description

OK Accept current changes and exit the Customize
Reporting dialog box.

Cancel Exit the Customize Reporting dialog box
without saving any changes.

Help Open the NetTune PRO Help Index.

File When you select a Comma Delimited or ASCII
Text file, this button becomes selectable. Click
it on to enter a name for your file.

Graph Open the Graph Options dialog box.

Add All Add all Class Data Items associated with the
selected Statistical Class to the graph or report.
Display selections in the Selected Data list box.

Add Add individual item from the Class Data Items
list box to the graph or report.
Display selections in the Selected Data list box.

Remove Remove the highlighted Class Data Item from
the Selected Data list box and the graph or
report.
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Using the Graph Options Dialog Box

Selecting the Graph button from the Customize Reporting dialog box opens the
Graph Options dialog box.

Following is a functional description of the check, list, selection, and text boxes
found in the Customize Reporting dialog box.

Graph Type

This list box is used to select the type of graph or chart used to represent server data.

Graph Style

This list box contains all graphing options associated with the currently selected
Graph Type. Options vary depending on the Graph Type selected.

Graph Title

Each graph that you create can be assigned a title. The Graph Title check box
enables or disables the title display.

Use the text box next to the Graph Title check box to enter a new graph title.
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X Axis

The X Axis selection box controls the horizontal coordinates for the graph.

Option Description

Title This check box is used to enabled the X axis
title display.
If empty, the title does not display.

Axis on Top This check box is used to display the X axis
on the top of the screen instead of the
bottom.
If empty, the X axis appears at the bottom of
the screen.

Variable Origins This check box is used to isolate a portion of
a large graph in order to closely examine a
smaller portion of the graph.
Variable Origin does not work with Stacked
Graph Styles.

Data Points This box is used to specify the number of
data points to display on each page.

Label Every This box is used to specify X axis domain
labeling intervals.

Tick Every This box is used to specify the X axis
domain tick mark intervals.

Y Axis Section

The Y Axis selection box controls the vertical coordinates for the graph.

Option Description

Title This check box is used to enabled the Y axis
title display.
If empty, the title does not display.

Axis on Right This check box is used to display the Y axis
on the right side of the screen.

Variable Orgins This check box is used to isolate a portion of
a large graph in order to closely examine a
smaller portion of the graph. Variable Origin
does not work with Stacked Graph Styles.
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Labels This check box is used to remove Y axis
range labels. This option creates more room
to display multiple data graphs.

Ticks This box is used to specify the number of
tick marks that display on the Y axis. The
NetTune PRO default value is five.

Maximum This box is used to specify the maximum
value to be graphed. If this value is set to
zero, the value defaults to auto scale mode.

Minimum This box is used to specify the minimum
value to be graphed. If this value is set to
zero, the value defaults to auto scale mode.

Miscellaneous Selection Box

This section of the Graph Options dialog box contains a number of custom settings.

Option Description

Hot Spots This check box enables the Graph feature to
pop-up text values.

Patterns When activated, this check box fills data
blocks with patterns representing different
graph colors. This is useful for printing
graphs on a gray-scale printer.

Legends This check box enables the legend for your
custom graph.

Statistics
(line type only)

Selecting a line graph from the Graph Type
list box activates the Statistics (Line Type)
list box.
This list box displays statistical graphing
options for line graphs.

Displaying a Custom Graph/Report

After setting all the custom graph options, click on the OK command push button to
return to the Customize Reporting dialog box.

Click on the OK button from the Customize Reporting dialog box to display your
custom graph/report.
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Save Custom Command

The Save Custom command is used to perform the following actions:

• Save a custom report

• Delete a custom report

• Update an existing custom report

• Rename a custom report

Saving a Customized Report

1. After creating a custom graph/report, highlight it and choose Save Custom from
the Statistics’ pull-down menu.

2. When the User Custom Reports dialog box appears, click on the Save button.

3. After the Report Name dialog box appears, enter a short descriptive name for
your custom report and click on the OK button.

4. After the User Custom dialog box appears, click on the Close button to end the
session.

5. When you return to the Statistics pull-down menu, note that the custom report
now appears in the Statistics pull-down menu.

Updating, Deleting, and Renaming Custom Reports

To update, delete, or rename a custom report:

1. Select the Save Custom command from the Statistics’ pull-down menu.

When the User Custom Reports dialog box appears, existing custom report
names are displayed in the Reports’ list box.
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2. Click on a custom report name in the Reports’ list box.

3. Click on either the Update, Delete, or Rename command button to initiate the
desired action.

4. Click on the Close button to end the session.

Printing Configuration and Statistical Information
Information found in the graphs or text reports in the Statistics menu can be output
to a printer for later reference. You can also print any of the configuration
information items located in the Information selection box under the Information
menu.

Printing a Report

You can print a report of your server configuration options by selecting the
information items and report topics you want to print.

1. Highlight an option in the Information selection box and click the left mouse
button once.

2. Mark the Printer check box with an X by clicking on the left mouse button.
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3. If you would like to include other options in the report, repeat the process from
Step 1. To deselect options, highlight the option and click in the Printer check
box to remove the X.

4. Once you have highlighted all the options you want to print, click on the Report
button at the bottom of the Server Configuration screen to print the report to
either a printer or an ASCII text file.

5. When you click the Report button, the Server Configuration Report topics
window appears.

6. Use the mouse to place an X next to the report topics you want to print. All of
the options you have highlighted for printing under the selected topics will be
printed. You can use the Select All or Deselect All buttons to quickly add or
remove topics.

7. Under Output, select a destination for the report. You can output the report to a
printer or to an ASCII text file.

• If you are sending the report to the printer, you can check the printer’s setup
using the Print Setup button. (See Setting Up Printers in this chapter for
more information on working with the Print Setup dialog box.) If the setup
is okay,  click the OK button and the report will print.

• If you send the report to a file, after you click the OK button, a dialog box
appears asking you for a filename. If you want to send your report to a file
that already exists, you can choose to append the report to the file (rather
than overwrite the file) by placing an X in the Append to Existing File
check box.
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Printing Graphs and Reports

Information found in the graphs or text reports in the Statistics menu can be output
to a printer for later reference.

To print a graph or report:

1. Display the graph or the text report.

2. Select Print from the File pull-down menu.

Optional method:

Click on the printer icon while the graph or report is on the screen.

Setting up Printers

The Print Setup dialog box shows the currently selected printer options. After you
designate a printer, you can select page orientation and page size options. The
number of options varies depending on the printer driver you select.

Print quality is set by selecting the Options button. Your Printer Options dialog box
may vary depending on your operating system (Windows for Work Groups or
Windows 3.1).
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Working with Memory Maps
NetTune PRO gives you with NLM memory information and can tell you how it
relates to the total system’s memory for a file server. This information is obtained
through the Maps menu.

Reporting NLM Memory

Use the NLM Memory command to report on NLM file server memory usage.

To view NLM Memory usage data:

Select the Maps menu and then click on the NLM Memory command.

The command displays all NLMs occupying memory, and how much memory each
segment of an NLM is using.

To view specific NLM Memory Information:

1. When the NLM Memory Map displays, NetTune PRO activates the Memory
Information Hot Key.

Position the Hot Key arrow in any NLM memory column segment.

NOTE: Click on the Toolbar Hot Key icon to activate or deactivate the hot key
feature.



96 Using NetTune PRO

2. Depress and hold down either mouse button to view segment contents and
amount of memory space occupied.

3. Use the Graph/Text toolbar button to toggle between a graph and text report.

The NLM Memory Map graph displays LOADER.EXE which is the part of the
NetWare Operating System that communicates with the file server’s hardware.

Viewing Memory Pool Information

The Memory Pool command shows where (in the system’s total segmented memory)
an application, utility, NLM, or data resides.

To select the Memory Pool graph:

Select the Maps Menu and click on the Memory Pool command.

This graph displays how much memory an application or NLM is using and where
in the system’s total memory that application or NLM is residing. This data can be
used to decide which NLMs to unload if system memory becomes limited.

To view Memory Pool Map data:

1. When the Memory Pool Map displays, NetTune PRO activates the Memory
Information Hot Key.

NOTE: If NetTune PRO’s cursor does not change, click on the toolbar Hot Key
icon to activate the Hot Key feature.

2. Position the Hot Key arrow in any segment of the NLM memory map.

3. Depress and hold down any mouse button to view segment contents and amount
of memory space occupied.
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4. Toggle between graph and text report with the Graph/Text toolbar button.

Viewing Information About NetTune PRO
The About NetTune PRO command in the Help menu brings up the About dialog
box containing information about the NetTune PRO program.

The About dialog box displays:

• The NetTune PRO icon

• The version number of program

• Copyright information

• The NETX, VIPX, and IPX program versions

• The amount of available system resources and memory



98

Chapter 7 Troubleshooting

Troubleshooting NetTune PRO Installation
If you encounter the error message, “Can’t initialize the Network,” check the
following:

• Workstation is running DOS version 5.0 or higher.

• Windows is running version 3.1 or higher.

• Windows is running in the 386 Enhanced mode.

• Windows is setup for a Network.

• Network shells are current.

The SYSTEM.INI file contains the following line:
Network=...,VIPX.386

NOTE:  The dots represent other possible arguments the network command may be
using.

Information for Windows for Workgroups Users

If you do not see any file servers listed in the “Servers” box, Windows for
Workgroups may not be set up for Network use.

To select an appropriate network:

• Double-click on the Network setup icon (from the Network group window).

• Next, click on the Network button.

• In the dialog box, select “Install Windows support for the following network
only.”

• Next, click on the  scroll bar to open the Network selection window.

• Use the scroll bar to select the appropriate NetWare version.

• When you have finished, click on the OK button twice to save your settings.
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Information for Windows 3.1 Users

If you do not see any file servers listed in the “Servers” box, this could mean your
Windows 3.1 is not set up for Network use.

To select an appropriate network:

• Select the Windows Setup icon from the Main window.

• Select Change System Settings from the Options pull down menu.

• Click on the Networks button and select the appropriate NetWare.

Information for NetWare 3.11 Users

The DPATCH.NLM is not required. However, if it’s not loaded, NetTune PRO’s
Disk Activity will always report zero.

NET31X.NLM automatically loads DPATCH.NLM, then DPATCH.NLM
automatically loads PATCHMAN.NLM.

Upgrading NetTune PRO NLMs
Before you install any new NetTune PRO NLMs, remove all older versions. This
can be accomplished from the file server’s console, or by launching
RCONSOLE.EXE from the NetTune PRO application.

Backing Up Historical Database Files
If you experience problems backing up your historical database files while the
NetTune PRO NLMs are loaded, use the NetWare flag utility to mark the database
files as Shareable.

flag +s *.ntd
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Dealing with Specific Problems
The following two situations may cause problems while running NetTune PRO.

RCONSOLE Fails to Load

If RCONSOLE fails to load, check the following:

• The console rights to that file server.
You must either log in as SUPERVISOR, or have console rights as a user.

• That enough memory is available.
Free up some resources to make more memory available.

• That the RCONSOLE.PIF contains the correct path.
Make sure the program information file (RCONSOLE.PIF) has the correct path
to RCONSOLE.

DLL Files Not Found While Running Windows on the Network

NetTune PRO looks locally for the Windows’ directory. This is where NetTune PRO
expects to find its DLL files. If your Windows is located on the network, copy the
DLL files in the NetTune PRO directory to the network Windows directory.

Reading the Release Notes
For additional release notes on NetTune PRO, click on the NetTune PRO ReadMe
icon in the BrightWorks program group, or use a text editor to open the
README.WRI file on the installation disk.
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Appendix A The NetTune PRO Menus

File Menu
The File menu is located in NetTune PRO’s menu bar at the top of the window. It
contains a list of NetTune PRO commands for the currently selected icon or object.

NCF

Selecting this command opens another selection window with the AUTOEXEC.NCF
and STARTUP.NCF files. To open a file for viewing or editing, click on the desired
file.

Close

The Close command is used to close the selected NCF file.

Save

The Save command is used to save the selected NCF file.

Print

The Print Command is used to print an active window.
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Print Preview

When you choose the Print Preview command, you can display either full page or
two page views of the active file or graph. While you are in print preview, you
cannot edit text or choose other commands.

Print Setup

The Print Setup command is used to select a printer driver and to set up the driver
options.

Exit

The Exit command is used to exit the NetTune PRO program.

NOTE: Remember to save all NCF files before exiting NetTune PRO.

Edit Menu
Clicking on Edit in the Menu Bar causes the Edit menu to appear. A number of edit
commands are available in the pull-down menu.

Undo

The Undo command is used to undo your most recent edit.

Cut

The Cut command deletes the highlighted text and pastes the text into the clipboard.
After cutting, you can paste the contents of the clipboard anywhere in a file.

Copy

The Copy command copies the highlighted text to the clipboard. After copying, you
can then paste the clipboard contents anywhere in a file. Many NetTune PRO
Windows that contain graphs and text can be copied to the clipboard.
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Paste

The Paste command is used to paste text from the clipboard into one or more
locations in your file. You must position the cursor where you want the text to
appear.

Tune Menu
The Tune pull-down menu, located on the NetTune PRO menu bar, allows you to
optimize server performance. It is only functional if you have the SmartTune NLM
loaded, otherwise, the Tune pull-down menu is grayed-out.

SET Parameters

The SET Parameters command allows you to modify SET parameters and create
custom Tune files. Tune files contain modified SET parameters for a file server. You
can schedule Tune files to change a server’s SET parameters at a specified time. You
can also export SET parameters from one server or Tune file to other servers or Tune
files.

Time Tune

The Time Tune command is used to create, schedule, or disable Tune Jobs through
the Time Tune dialog box. A Tune Job is the scheduling or unscheduling of a Tune
file.

SmartTune

Using sophisticated artificial intelligence, SmartTune is able to automatically adjust
SET parameters on the fly, based on real-time data.

Information Menu
The Information menu provides the following data:

• File server configuration
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• NLMs loaded

• Current SET parameter values

Connections summary

Server Configuration

Use the Server Configuration pull-down menu to quickly check the server’s
configuration. From the Server Configuration dialog, select any server in the
Server’s selection box. Detailed server configuration statistics and information
become accessible for the selected server. The data fields are updated every five
seconds.

NLMs Loaded

The NLMs Loaded command reports the following specific NLM information:

• Name

• Code size

• Data size

• Total size

• Version

• Date

• Description

SET Parameter Values

The SET Parameters Values command reports the following SET parameter
information:

• SET parameter name

• Current value

• SET parameter range
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Connections Summary

The Connections Summary command is used to display or print a report containing
the following Connection information:

• Connection number

• Login name

• Number of minutes connected

• Total NCP requests

• Total bytes read

• Total bytes written

• Network address

Statistics Menu
The Statistics menu provides pre-defined graphs and reports on all aspects of
NetWare statistics. Graphs and charts display file server activity over a specified
period of time.

Any graph can be changed to another style (2D, 3D, Pie, Line, etc.) by selecting the
Graphs Option icon from the Toolbar menu, or by selecting the Customize
command from the Statistics’ pull-down menu.
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Network Statistics

The graph shows the amount of packet activity over the network for a specific period
of time. Network activity is displayed in three statistics:

• Packets Received

• Packets Transmitted

• Packets Routed

Disk Statistics

The graph shows the amount of disk activity for a specific period of time. Disk
activity is displayed in three statistics:

• Disk Reads

• Disk Writes

• Disk Requests

Connection Statistics

The graph shows the number of users connected to the server for a specific period of
time. Connection activity is for the connected stations.

Utilization Statistics

The graph shows the percentage of CPU utilization on the server for a specific
period of time. Higher percentages indicate a busy server.

Volume Statistics

The graph displays the volume size in bytes. The Volume Statistics are broken down
into four parts:

• Used

• Available

• Purgeable

• Not Yet Purgeable
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LAN Segment Statistics

The graph displays the amount of packet activity (in number of packets) on each
LAN segment for a specific period of time. LAN Segment activity is broken down
into Total Packet for a LAN Adapter.

The representation of Total Packets for a LAN Adapter depends on the number of
LAN adapters installed in the file server. Each LAN adapter is represented by a
different color in the Legend.

Memory Statistics

The graph displays the memory usage and allocation for a specific period of time.
The Memory Statistics are displayed in five parts:

• Cache memory

• Permanent memory

• Allocated memory

• Movable memory

• Non-movable memory

Free Space Statistics

You can view a Free Space Statistics graph by selecting the Free Space command
from the Statistics pull-down menu. The graph displays the number of free bytes in a
volume for a specific period of time. Each color on the Graph represents a volume
on that server.

Read Ratio Statistics

The graph displays an approximate Cache Hit Ratio over a specific period of time.
The Read Ratio statistics are broken down into two parts:

• Disk Reads

• File Reads
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Cache Buffers Statistics

The graph displays the Cache Buffer Statistics for a specific period of time. The
Cache Buffer statistics are displayed in four parts:

• Current Cache Buffers

• Directory Cache Buffers

• Receive Cache Buffers

• Dirty Cache Buffers

Customize

NetTune PRO enables you to create custom report/graphs from predefined reports.
After opening one of the Statistics menu predefined statistical reports, the Customize
command is used to modify and create a new report/graph. After you create a new
report/graph, you can name it, save it, and use it to run the report later.

Recording Intervals

To take full advantage of NetTune PRO, you should set up the preferred historical
recording intervals before you install the NLM software. Once the NLM software is
installed and loaded, it immediately begins collecting data based on the NetTune
PRO default recording intervals defined at the time of install.

Maps Menu
NetTune PRO provides NLM memory information and how it relates to the total
system’s memory for a file server. This information is obtained through the Maps
menu.

NLM Memory

Use the NLM Memory command to report on NLM file server memory usage.

Memory Pool

The Memory Pool command shows where (in the system’s total segmented memory)
an application, utility, NLM, or data resides.
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Tools Menu
The Tools menu provides the following NetWare tools:

• NLM Install

• RCONSOLE

NLM Install

The NLM Install option is used to install the NetTune PRO NLMs on a file server as
described in installation sections.

RCONSOLE

The RCONSOLE option automatically loads Novell’s RCONSOLE. The remote
console can be used as a virtual file server console to load and unload NLMs from
inside the NetTune PRO application.

Options Menu
The Options menu contains several customization and utility commands to help you
use NetTune PRO more effectively.
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Save Settings on Exit

The Save Settings on Exit command is used to save the NetTune PRO desktop when
quitting NetTune PRO. A check mark next to the command means it is in effect. By
default, NetTune PRO saves the desktop in the NETTUNE.INI file. When the
NetTune PRO program is started, NETTUNE.INI is used to restore the desktop.

Group Management

The group management command is used to organize and manage the NetTune PRO
desktop by arranging servers into groups.

Login

The Login command is used to log in to a file server to gain console rights.

Logout

The Logout command is used to break the connection between the current
workstation and the file server.

Login Status

The Login Status command is used to enable or disable logins to the file server. If
disabled, users are unable to log in to the server. The default for Login Status is
Enabled.

Down Server

It is necessary to occasionally take down a file server for maintenance. The Down
Server command is used to gracefully take down a file server.

CAUTION: It is a good idea to schedule shutdowns. Downing a file server “cold”
guarantees damage to user files. This command should be executed only after all
users have logged off the server.

Always warn all users before you shut down a file server.

Toolbar

The Toolbar at the top of NetTune PRO’s desktop is displayed by default. A check
mark next to the command means it is in effect.
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Status Bar

The Status Bar at the bottom of NetTune PRO’s desktop is displayed by default. A
check mark next to the command means it is in effect.

Window Menu
The Window menu is located on the right side of the Menu Bar at the top of the
NetTune PRO Window. The commands in this menu allow you to control the
display of application windows. A number of optional commands are available in
the pull-down menu.

Cascade

The Cascade command is used to arrange all open application windows so that they
are visible in the NetTune PRO window. The command causes the windows to
overlap so that each open application’s title bar is visible.

Tile Vertical Window menu

The Tile Vertical command is used to arrange all open application windows so that
they are visible in the NetTune PRO window. The command causes the windows to
vertically stack so that each open application window is visible.

Tile Horizontal

The Tile Horizontal command is used to arrange all open application windows so
that they are visible in the NetTune PRO window. The command causes the
windows to horizontally stack so that each open application window is visible.

Arrange Icons

The Arrange Icons command is used to organize all scattered icons. The command
causes the icons to align at the bottom of the NetTune PRO window so that each
icon is visible.



112 Using NetTune PRO

Application Window

NetTune PRO permits you to have several windows and icons open simultaneously.
The Window command displays a list of the open icons and windows at the bottom
of the cascading menu. To select the window you want, click on the appropriate
name.

If more windows are open than can be displayed in the cascading menu, the
command “More Windows...” appears at the bottom of the Window menu. Click on
the More Windows command to open the Select Window dialog box.

Help Menu
NetTune PRO is equipped with a built-in Help utility that can help you use NetTune
PRO.

Selecting the Help menu allows you to:

• Access the Help Index for NetTune PRO. The Help Index is the table of
contents for NetTune PRO commands and concepts.

• Access the Using Help utility. The Using Help utility brings up a table of
contents of all the concepts related to using Window’s help.

• Access the Quick Start dialog box for additional configuration changes.

• View the About NetTune PRO dialog box.

Index

The Index command opens NetTune PRO’s Help Index window.

Using Help

The Using Help command opens the How to Use Help window.
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NetTune PRO Quick Start

The Quick Start command allows you to install NLMs, view a server’s
configuration, set up Recording Intervals, and create Groups for NetTune PRO’s
desktop.

NetTune PRO Advisor

The NetTune PRO Advisor is an on-line Help utility that is located on NetTune
PRO’s tool bar, or in the Help pull-down menu.

About NetTune PRO

The About NetTune PRO command brings up the About dialog box containing
information about the NetTune PRO program.
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Appendix B The NetWare SET Parameters

The following NetWare version 3.11, 3.12, and 4.10 SET parameters are supported
by NetTune PRO.

Parameters are listed alphabetically by name. Each parameter is followed by a
description and a table that includes the applicable NetWare version(s), the range
limit(s), the default setting, and notes that tell you where you can find the SET
parameter in NetTune PRO.

Alert Message Nodes

This parameter specifies the number of alert message nodes that have been
previously allocated.

Version(s): 4.10

Limits: 10 to 256

Default: 20

Notes: Under Tune\SET
Parameters\Miscellaneous.

Alloc Memory Check Flag

This parameter specifies whether the server will perform corruption checking in the
alloc memory nodes.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Memory.
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Allow Change To Client Rights

This parameter allows the client rights to be changed.

NOTE: Some job servers and third-party applications can’t function without
changing to client rights. Using OFF may prevent some job servers from getting
access to the files they need, but it prevents the forging of a packet through the job
or print server.

Version(s): 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous or NCP
Parameters.

Allow Deletion of Active Directories

This parameter specifies whether a directory can be deleted when another connection
has a drive mapped to it.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File System.

Allow Invalid Pointers

This parameter specifies whether invalid pointers are allowed to cause a nonexistent
page to be mapped in with only one notification.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Memory.
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Allow LIP

This parameter allows the client’s rights to be changed (Allow Large Internet Packet
support).

Version(s): 3.12, 4.10

Limits: ON, OFF

Default ON

Notes: Under Tune\SET
Parameters\Communications or NCP
Parameters.

Allow Unencrypted Passwords

This parameter controls the use of unencrypted passwords. If set to ON, users are
allowed to use both encrypted and unencrypted passwords. If set to OFF, users may
use only encrypted passwords.

NOTE: In order to set this parameter to OFF on a network that has file servers
running NetWare v2.12 and above, but none running v2.0a, you must copy the
NetWare v3.1x utilities to these file servers.

If all file servers are running NetWare v3.1x, set to OFF. If there are file servers
running NetWare v2.0a, set to ON.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Allow Unowned Files To Be Extended

This parameter specifies whether files can be modified when the owner has been lost
or deleted.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File System.
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Automatically Repair Bad Volumes

This parameter is used to specify whether VREPAIR runs automatically on a volume
that fails to mount.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Miscellaneous.

Auto Register Memory Above 16 Megabytes

This parameter is used to control the automatic register of memory above 16MB in
EISA computers. Using this parameter, you can automatically add memory that can
be detected above 16 megabytes on EISA bus machines.

Set to ON if you want the operating system to register memory above 16MB. Set to
OFF if your file server has a network board or a disk adapter board that uses on-line
DMA or AT bus mastering.

NOTE: This parameter cannot be modified at the console prompt. SmartTune
modifies the STARTUP.NCF. Reboot the file server to implement the new
parameter.

Version(s): 3.11, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Memory.

Auto TTS Backout Flag

This parameter controls whether a crashed file server will backout any incomplete
transactions when rebooted. Used to automatically do TTS backouts during a re-boot
(It will skip the prompts).

If set to ON, the file server will automatically back out any incomplete transactions
during a reboot. If set to OFF, the file server prompts you with the following
message before completing its bootstrap:

Incomplete transaction(s) found. Do you want to back them out?
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NOTE: This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: 3.11, 3.12: OFF
4.10: ON

Notes: Under Tune\SET Parameters\Transaction
Tracking.

Bindery Context

This parameter is used to specify one or more containers to be used by NetWare
Directory Services when it provides bindery services. Multiple contexts are
separated by semicolons. To set multiple contexts, you must have a replica of the
container you specify in the context on the same partition. For example,

SET BINDERY CONTEXT = OU=SALES_LA.OU=SALES.
O=NOVELL_US;OU=ACCOUNTING.O=NOVELL

Version(s): 4.10

Limits: Maximum: 256 characters. Up to 16
contexts.

Notes: Under Tune\SET Parameters\Directory
Services

Cache Buffer Size

This parameter sets the block size of the cache buffer. If block allocations are greater
than 4KB on all volumes, increasing this parameter may increase performance. If
block allocations are less than 4KB on all volumes, increasing this parameter
decreases performance.

NOTE: Volumes that have block allocation sizes smaller than the cache block size
are not be mounted.

If block allocation sizes vary between volumes, make this parameter no larger than
the smallest block allocation size.
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NOTE: This parameter cannot be modified at the console prompt. SmartTune
modifies the STARTUP.NCF. Reboot the file server to implement the new
parameter. This parameter may also be modified using the -c option when starting
the SERVER.EXE program.

Version(s): 3.11, 3.12

Limits: 4096 to 16384

Default: 4096

Notes: Under Tune\SET Parameters\Memory.

Compression Daily Check Stop Hour

This parameter specifies the hour when you want the file compressor to stop
scanning enabled volumes for files that need to be compressed. Hours are specified
by a 24-hour clock: 0 = midnight; 23 = 11 p.m.

Version(s): 4.10

Limits: 0 to 23

Default: 6

Notes: Under Tune\SET Parameters\File
System

Compression Daily Check Starting Hour

This parameter specifies the hour when you want the file compressor to start
scanning enabled volumes for files that need to be compressed. Hours are specified
by a 24-hour clock: 0 = midnight; 23 = 11 p.m.

NOTE: If the Compression Daily Check Stop Hour parameter is the same as the
“Compression Daily Check Starting Hour,” then the file compressor starts checking
every day at the Compression Daily Starting Hour time and runs as long as
necessary to finish all files that meet the compressible criteria.

Version(s): 4.10

Limits: 0 to 23

Default: 0

Notes: Under Tune\SET Parameters\File
System.
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Concurrent Remirror Requests

This parameter sets the number of remirror requests per logical partition.

Version(s): 3.12, 4.10

Limits: 3.12: 2 to 30
4.10: 2 to 32

Default: 4

Notes: Under Tune\SET Parameters\Disk.

Console Display Watchdog Logouts

This parameter determines whether a console message is displayed when a
workstation connection is cleared. A smoothly running network does not require the
display of this parameter. If your workstations are having connection problems, the
watchdog logout messages can help you isolate which stations aren’t receiving or
sending watchdog packets.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Communications.

Convert Compressed to Uncompressed Option

This parameter is used to specify what the system does with an uncompressed
version of a file after the server has uncompressed it. The options are: 0 = always
leave the file compressed; 1 = leave the file compressed until second access if it is
read only once during the time specified by the Days Untouched Before
Compression parameter; 2 = always leave the file uncompressed.

Version(s): 4.10

Limits: 1 to 2

Default: 1

Notes: Under Tune\SET Parameters\File
System.
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Daylight Savings Time Offset

This parameter controls the offset applied to time calculations when daylight saving
time is in effect. This parameter causes UTC time to be recalculated from local time.

Version(s): 4.10

Default: +1:00:00

Notes: Under Tune\SET Parameters\Time.

Daylight Savings Time Status

This parameter is used to indicate whether daylight saving time is in effect. If this
parameter is set to ON, you should also useb the Daylight Savings Time Offset
parameter. Changing the daylight saving time status does not change the local time.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time.

Days Untouched Before Compression

This parameter specifies the number of days the system waits after a file was last
accessed before it is compressed.

Version(s): 4.10

Limits: 0 to 100000

Default: 7

Notes: Under Tune\SET Parameters\File
System.
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Decompress Free Space Warning Interval

This parameter is used to specify the time between alerts when the file system is not
changing compressed files to uncompressed because of insufficient disk space.

Version(s): 4.10

Limits: 0 seconds to 29 days 15 hours 50
minutes 3.8 seconds.

Default: 31 minutes 18.5 seconds

Notes: Under Tune\SET Parameters\File
System.

Decompress Percent Disk Space Free to Allow Commit

This parameter specifies the percentage of free disk space required on a volume for
file uncompression to permanently change compressed files to uncompressed. The
parameter prevents newly uncompressed files from filling up the volume.

Version(s): 4.10

Limits: 0 to 75

Default: 10

Notes: Under Tune\SET Parameters\File
System.

Default Time Server Type

This parameter is used to specify the default time synchronization server type. This
parameter can be overridden by other time synchronization parameters.

Version(s): 4.10

Limits: Supported types: Reference, Primary,
Secondary, Single Reference.
Maximum: 50.

Default: Secondary

Notes: Under Tune\SET Parameters\Time.
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Delay Before First Watchdog Packet

Sets the amount of time the server waits without receiving a workstation request
before it  sends out the first watchdog packet. The value is the time the server waits
without receiving a request from the workstation, before it asks the workstation if it
is still attached to the file server.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 15.7 sec. to 20 minutes 52.3
seconds
4.10: 15.7 seconds to 14 days

Default: 4 minutes 56.6 seconds

Notes: Under Tune\SET
Parameters\Communications.

Delay Between Watchdog Packets

This parameter sets the amount of time between watchdog packets after the server
has sent out the first watchdog packet. The number is the amount of time the server
will wait for an inactive workstation to reply to a watchdog packet, before asking the
workstation again if it is still attached to the file server.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 9.9 seconds to 10 minutes
26.1 seconds
4.10: 9.9 seconds to 10 minutes 26.2
seconds

Default: 59.3

Notes: Under Tune\SET
Parameters\Communications.
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Deleted Files Compression Option

This parameter specifies whether and when deleted files are compressed. The
options are: 0 = don’t compress deleted files; 1 = compress deleted files the next
day; 2 = compress deleted files immediately.

Version(s): 4.10

Limits: 0 to 2

Default: 1

Notes: Under Tune\SET Parameters\File
System.

Developer Option

This parameter controls whether options associated with a developer environment
are enabled.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Directory Cache Allocation Wait Time

This parameter sets the length of time the operating system must wait between the
allocation of new directory cache buffers. During this time period all directory cache
buffer allocation requests are ignored. The number is the minimum time to wait
between new directory cache buffer allocations.



Using Nettune PRO 125

Increasing this parameter causes the operating system to be slow in allocating
directory cache buffers. Decreasing this parameter causes more memory resources to
be allocated to directory caching.

Version(s): 3.11, 3.12, 4.10

Limits: 0.5 seconds to 2 minutes

Default: 2.2 seconds

Notes: Under Tune\SET Parameters\Directory
Caching.

Directory Cache Buffer NonReferenced Delay

This parameter sets the length of time a directory entry must be cached before it can
be overwritten by another directory entry. The number indicates the normal time to
wait after a directory cache buffer was referenced before re-using it.

Increasing this parameter causes the operating system to allocate more directory
cache buffers. Decreasing this parameter causes directory access to slow down, but
decreases the need for additional cache buffers.

Version(s): 3.11, 3.12, 4.10

Limits: 1 second to 5 minutes

Default: 5.5 seconds

Notes: Under Tune\SET Parameters\Directory
Caching.

Dirty Directory Cache Delay Time

This parameter sets the length of time the operating system keeps a directory table
write request in memory before writing it to disk. The number is the minimum time
the system waits before writing a dirty directory cache buffer.

Increasing this parameter increases operating system performance. However, the
probability of the directory table becoming corrupted is also increased.
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Decreasing this parameter reduces operating system performance due to an added
number of disk writes. However, the probability of the directory becoming corrupted
is reduced.

Version(s): 3.11, 3.12, 4.10

Limits: 0 seconds to 10 seconds

Default 0.5

Notes: Under Tune\SET
Parameters\Directory Caching.

Dirty Disk Cache Delay Time

Sets the amount of time the operating system keeps a write request (that does not fill
a cache buffer) in memory before writing the request to disk. The number is the
minimum amount of time the system waits before writing a not completely dirty
disk cache buffer.

Increase this parameter if users are making many small write requests. Decreasing
this parameter slightly reduces the chances of losing data. However, you may
drastically reduce performance.

Version(s): 3.11, 3.12, 4.10

Limits: 0.1 seconds to 10 seconds

Default: 3.3 seconds

Notes: Under Tune\SET Parameters\File
Caching.

Display Disk Device Alerts

This parameter controls the display of hard disk informational messages. When set
to ON, it displays alert messages when a disk device is added, deleted, mounted,
activated, deactivated, etc.

If set to ON, a message is generated every time a hard disk is added, activated,
deactivated, mounted, or dismounted. Set to OFF if you are not experiencing hard
disk problems.

Version(s): 3.11, 3.12

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.
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Display Incomplete IPX Packet Alerts

This parameter controls messages about IPX alerts. It displays alert messages when
IPX receives incomplete packets.

If set to ON, displays alert messages when the IPX receives incomplete packets.

NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the amount of memory allocated to the “Alloc Memory Pool.”

Version(s)
:

3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous.

Display Lost Interrupt Alerts

This parameter controls the display of lost interrupt messages. It displays alert
messages when the interrupt controller detects a lost hardware interrupt.

If an interrupt request from a driver or board is dropped before the CPU is able to
respond to the request, the following message is generated:

Interrupt controller detected a lost hardware interrupt

This message indicates a hardware or driver problem which may degrade system
performance.

If your file server console displays lost interrupt messages:

• Unload all drivers.

• Reload them one at a time to determine which driver is causing the problem.

• Contact the vender of driver causing the problem. Set this parameter to OFF
while you are waiting for a resolution.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous.



128 Using NetTune PRO

Display Old API Names

This parameter controls the display of old NetWare v3.0 API calls. NetWare 3.1x
renamed some of the APIs as additional resources were tracked. The old APIs work,
but more slowly than the new APIs. When set to ON, the parameter displays the
names of old API routines that a module is using when the module is loaded.

Set to ON if you are writing your own NLMs and are upgrading NetWare 3.0 NLMs
to new 3.1x APIs. Set to OFF if no v3.0 NLMs are being upgraded to NetWare 3.1x
APIs. If you are receiving these messages, contact the vendor of the module
generating these messages.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Display NCP Bad Component Warnings

This parameter controls whether NCP bad component alert messages are displayed.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\NCP

Display NCP Bad Length Warnings

This parameter control whether NCP bad length alert messages are displayed.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\NCP
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Display Relinquish Control Alerts

This parameter controls the display of CPU control messages. This parameter can be
used as a debugging tool. If an NLM uses the CPU for more than .4 seconds without
releasing control to other processes, a control alert message is generated. Set to ON
only if you are writing your own NLMs.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Display Spurious Interrupt Alerts

This parameter controls display of spurious interrupt alert messages. When set to
ON, it displays alert messages when a spurious hardware interrupt is detected.

A message is sent to the file server console whenever the hardware in the file server
creates an interrupt that has been defined and reserved for another device.  Spurious
interrupts generate the following type of message:  Spurious hardware interrupt
<number> detected

NOTE: Spurious interrupt message indicates a serious error in the hardware. If your
file server console displays spurious interrupt messages, remove all add-on boards
and run SERVER.

If the message does not appear, add the boards one at a time until you have
discovered which piece of hardware is creating the spurious interrupt. Contact the
vender of the hardware causing the problem. Set this parameter to OFF while you
are waiting for a resolution.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous.
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Enable Disk Read After Write Verify

This parameter controls whether data written to disk is compared with memory.
Normally this parameter is ON. If you need extra disk speed on writes and your
disks are reliable and mirrored, setting this parameter to OFF can nearly double your
disk speed. When ON, all data written to disk is reread to verify correctness.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Disk.

Enable File Compression

This parameter is used to specify whether file compression is suspended. An ON
setting allows file compression on compression-enabled volumes. An OFF setting
suspends compression; immediate compress requests are queued until value is reset
to ON, when the files meeting criteria will be compressed.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File
System.

Enable IPX Checksums

This parameter enables the checksums of IPX packets (0 = no check sums, 1 = check
sum if enabled at the client, 2 = requires check summing).

Version(s): 3.12, 4.10

Limits: 0 to 2

Default: 1

Notes: Under Tune\SET
Parameters\Communications or NCP
Parameters..
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Enable Packet Burst Statistics Screen

This parameter displays the NCP packet burst statistics screen.

Version(s): 3.12

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Communications.

End of Daylight Savings Time

This parameter is used to specify the local date and time when the change from
daylight saving time should occur.

IMPORTANT: You must set both the start and the end of daylight saving time
before either date is actually scheduled.

Version(s): 4.10

Limits: Maximum: 79 characters

Notes: Under Tune\SET Parameters\Time.

File Delete Wait Time

Sets the amount of time the operating system is required to wait before marking a
salvageable file as purgeable. When the volume becomes full, the operating system
begins to delete the oldest purgeable files to create free space on the volume.

Increase this parameter as necessary for the system users. If the volume becomes
full, files that have not met the limit are still purged.

Version(s): 3.11, 3.12, 4.10

Limits: 0 seconds to 7 days

Default: 5 minutes 29.6 seconds

Notes: Under Tune\SET Parameters\File
System.
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Garbage Collection Interval

This parameter specifies the maximum time between garbage collections.

Version(s): 4.10

Limits: 1 minute to 1 hour

Default: 15 minutes

Notes: Under Tune\SET Parameters\Memory.

Global Pseudo Preemption

This parameter is used to specify whether or not all threads use pseudo preemption.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Halt System on Invalid Parameters

This parameter specifies whether to stop the system when invalid parameters are
detected. Set the parameter to ON if you want the system to halt when an invalid
parameter or condition is detected. Set the parameter to OFF if you want the system
to display an alert and continue running when an invalid parameter or condition is
detected.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Immediate Purge Of Deleted Files

This parameter controls the salvageable file features. When ON, all files are purged
immediately upon deletion.

If set to ON, all NetWare salvage features are disabled. All files are immediately
purged when deleted. If set to OFF, files may be salvaged with the NetWare
SALVAGE utility.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: OFF
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Notes: Under Tune\SET Parameters\File
System.

IPX NetBIOS Replication Option

This parameter specifies how the IPX router handles replicated NetBIOS broadcasts.
The options include: 0 = do not replicate NetBIOS broadcasts; 1 = duplicate
broadcasts when there are redundant routes; 2 = suppress duplicate broadcasts.

Version(s): 4.10

Limits: 0 to 2

Default: 2

Notes: Under Tune\SET
Parameters\Communications.

Maximum Alloc Short Term Memory

This parameter sets the amount of memory the operating system allocates to the
Short-Term Memory pool. The default setting is sufficient for 250 users, each with
26 drive mappings. The number indicates the maximum amount of memory
available to the work dynamic memory pool.

Increase this parameter if the file server issues warnings that an operation cannot be
completed because the memory pool has reached its limits.

Decrease this parameter if the file server is allocating more memory to the pool than
normally required.

NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the amount of memory allocated to the “Alloc Memory Pool.”

Version(s): 3.11, 3.12

Limits: 3.11: 50000 to 16777216
3.12: 50000 to 33554432

Default: 3.11: 2097152
3.12: 8388608

Notes: Under Tune\SET Parameters\Memory.
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Maximum Concurrent Compressions

This parameter specifies the maximum concurrent or simultaneous compressions
allowed. Concurrent compressions can occur only if there are multiple volumes.

Version(s): 4.10

Limits: 1 to 8

Default: 2

Notes: Under Tune\SET Parameters\File
System.

Maximum Concurrent Directory Cache Writes

This parameter sets the number of write requests from the directory cache buffers
that can be placed into the elevator before the disk head begins a sweep across the
disk. The number indicates the maximum number of concurrent writes of directory
cache buffers.

Increasing this parameter improves the efficiency of servicing write requests.
However, the servicing of read requests becomes less efficient.

Decreasing this parameter improves the efficiency of servicing read requests.
However, the servicing of write requests becomes less efficient.

Version(s): 3.11, 3.12, 4.10

Limits: 5 to 50

Default: 10

Notes: Under Tune\SET
Parameters\Directory Caching.

Maximum Concurrent Disk Cache Writes

This parameter sets the number of write requests for changed file data that can be put
into the elevator before the disk head begins a sweep across the disk. The number
indicates the maximum number of concurrent writes of dirty disk cache buffers.

Increasing this parameter makes the servicing of write requests more efficient.

Decreasing this parameter makes the servicing of read requests more efficient.
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NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the number of dirty cache buffers. If the number is above
70% of the total cache buffers, increase this parameter to optimize the write speed.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11: 10 to 100
3.12: 10 to 1000
4.10: 10 to 4000

Default: 50

Notes: Under Tune\SET Parameters\File
Caching.

Maximum Directory Cache Buffers

This parameter sets the number of permanent directory cache buffers the operating
system may allocate. The number represents the maximum number of directory
cache buffers that can be allocated by the system.

Increase this parameter if the file server responds slowly to directory searches.

Decrease this parameter if too much memory is being allocated for directory
caching.

NOTE: If users are notified by the operating system that the server is low on
memory, this parameter should be one of the first to be reduced.

You must reboot the file server to return the memory to the cache buffer memory
pool.

Version(s): 3.11, 3.12, 4.10

Limits: 20 to 4000

Default: 500

Notes: Under Tune\SET Parameters\Directory
Caching.
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Maximum Extended Attributes per File or Path

This parameter sets the number of extended attributes that can be assigned to a file
path for all volumes on the server. The number is the allowable number of extended
attributes for files or paths.

Version(s): 3.11, 3.12, 4.10

Limits: 4 to 512

Default: 3.11: 32
3.12: 8
4.10: 16

Notes: Under Tune\SET Parameters\File
System.

Maximum File Locks

This parameter sets the number of opened and locked files the operating system can
handle. The number indicates the system-wide maximum number of file locks
permitted (including open files).

Increase this parameter if the current number of open files is near or equal to the
default setting.

Decrease this parameter to restrict the number of file server resources.

NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the number of files that are open during peak usage

Version(s): 3.11, 3.12, 4.10

Limits: 100 to 100000

Default: 10000

Notes: Under Tune\SET Parameters\Locks.

Maximum File Locks Per Connection

This parameter controls how many opened and locked files a station can use at a
time. The number is the maximum number of file locks per connection permitted
(including open files).

Increase this parameter when an application cannot open enough files and fails. An
OS/2 station may require a higher default than 250.

You may also be required to increase the number of file handles in the workstation’s
SHELL.CFG file.

Decrease this parameter if workstations are using too many file server resources.
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NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view how many opened and locked files a workstation is using.

Version(s): 3.11, 3.12, 4.10

Limits: 10 to 1000

Default: 250

Notes: Under Tune\SET Parameters\Locks.

Maximum Interrupt Events

This parameter specifies the maximum number of interrupt time events (such as IPX
routing) that are allowed before a thread switch is guaranteed to have occurred.

Version(s): 4.10

Limits: 1 to 1000000

Default: 10

Notes: Under Tune\SET
Parameters\Communications.

Maximum Number of Directory Handles

This parameter specifies the maximum number of directory handles available for
each connection. A directory handle is a version of the directory access rights that is
held in cache memory. Caching the access rights speeds mapping to the rights. Each
time a connection accesses a file or directory, a directory handle is allocated (up to
the total specified by this parameter).

Version(s): 4.10

Limits: 20 to 1000

Default: 20

Notes: Under Tune\SET Parameters\Directory
Caching.

Maximum Number of Internal Directory Handles

This parameter specifies the maximum number of directory handles available for
internal NLMs that use connection 0. A directory handle is a version of the directory
access rights that is held in cache memory. Caching the access rights speeds
mapping to the rights. Connection 0 is the connection number reserved for use by
the server itself and by NLMs operating within the server.
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Each time an NLM program using connection zero accesses a file or directory, a
directory handle is allocated (up to the total specified by this parameter). This value
represents the total number of handles available to be shared by all NLMs using
connection 0.

Version(s): 4.10

Limits: 40 to 1000

Default: 100

Notes: Under Tune\SET Parameters\Directory
Caching.

Maximum Outstanding NCP Searches

This parameter sets the maximum number of NetWare Core Protocol (NCP)
directory searches that may be processed at the same time. The number is the
maximum number of simultaneous NCP directory searches that a connection can
have.

Under normal conditions, only one NCP directory search occurs at a time. Increase
this parameter only if you are using applications that support multiple directory
search operations simultaneously, and you are having problems with corrupted or
invalid directory information.

Version(s): 3.11, 3.12, 4.10

Limits: 10 to 1000

Default: 51

Notes: Under Tune\SET
Parameters\Miscellaneous or NCP
Parameters.

Maximum Packet Receive Buffers

This parameter sets the maximum number of packet receive buffers that the
operating system can allocate.

EISA and Micro Channel server bus master boards require at least 5 buffers per
board.

Use NetWare’s MONITOR.NLM to determine if the board is producing “No ECB
available count “ errors. This can be done by selecting LAN Information from the
Monitor program. If you detect these errors, increase the parameter to allow for 10
packet receive buffers per board.

If you observe that the number of allocated services processes have reached fixed
limits, increase the “maximum number of service processes” parameter.
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NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the current server usage for packet receive buffers and service
processes.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 50 to 2000
4.10: 50 to 4000

Default: 3.11: 100
3.12: 400
4.10: 100 (SFT III systems=400)

Notes: Under Tune\SET
Parameters\Communications

Maximum Percent of Volume Space Allowed for Extended Attributes

This parameter sets a limit on the portion of volume space that may be used for
extended attribute storage. The number is the percent of volume space allowed for
Extended Attributes storage.

NOTE: This parameter only takes effect while the volume is being mounted.

Version(s): 3.11, 3.12, 4.10

Limits: 5 to 50

Default: 10

Notes: Under Tune\SET Parameters\File
System.

Maximum Percent of Volume Used By Directory

This parameter sets a limit on the portion of a volume that may be used as directory
space. The number is the maximum percent of each volume that can be allocated for
the directory.

Version(s): 3.11, 3.12, 4.10

Limits: 5 to 50

Default: 13

Notes: Under Tune\SET Parameters\File
System.

Maximum Physical Receive Packet Size

This parameter sets the maximum packet size the file server can transmit to any
network. The number indicates the size of the largest packet that can be received by
an MLID. The default packet size is 1KB, which includes the packet header and
data.
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The default is also acceptable for Token-Ring or Ethernet boards. Set this parameter
to the largest packet size allowed by your network boards.

NOTE: This parameter cannot be modified at the console prompt. SmartTune
modifies the STARTUP.NCF. Reboot the file server to implement the new
parameter.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11: 618 to 4202
3.12, 4.10: 618 to 24682

Default: 3.11: 1130
3.12: 1514
4.10: 4202

Notes: Under Tune\SET
Parameters\Communications.

Maximum Record Locks

This parameter sets the number of record locks the operating system can handle. The
number indicates the system-wide maximum number of record locks (physical,
logical and semaphores).

Increase this parameter if users are having trouble running applications, and are
receiving messages indicating that an insufficient number of memory locks are
available.

Decrease this parameter if users are using too many file server resources.

NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the number of record locks a workstation is using.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 100 to 200000
4.10: 100 to 400000

Default: 20000

Notes: Under Tune\SET Parameters\Locks.

Maximum Record Locks Per Connection

This parameter sets the number of record locks a station can use at one time. The
number is the maximum number of record locks per connection (physical, logical
and semaphores).

Increase this parameter when an application fails because it is unable to lock enough
records.

Decrease this parameter if workstations are using too many file server resources.
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NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view how many record locks a workstation is using.

Version(s): 3.11, 3.12, 4.10

Limits: 10 to 10000

Default: 500

Notes: Under Tune\SET Parameters\Locks.

Maximum Service Processes

This parameter sets the maximum number of service processes that the operating
system may create.

Increase this parameter if the number of currently allocated service processes is at
the maximum. Increasing this parameter will only help if more than 20 requests are
being delayed simultaneously for a disk I/O to be completed.

Temporarily decrease this parameter if the file server is low on memory. Add
memory if the file server is always low on memory.

NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view the number of service processes that have currently been
allocated.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 5 to 40
4.10: 5 to 100

Default: 3.11, 3.12: 20
4.10: 40

Notes: Under Tune\SET
Parameters\Miscellaneous.

Maximum Subdirectory Tree Depth

This parameter sets the number of subdirectories the operating system will support.
Some DOS directories are not capable of supporting more than 10 levels if the
directories have eleven-character names.

Increase this parameter if application support trees are deeper than 25 levels.

Decrease this parameter if your application supports only shallow tree structures.
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NOTE: This parameter cannot be modified at the console prompt. SmartTune
modifies the STARTUP.NCF. Reboot the file server to implement the new
parameter.

Version(s): 3.11, 3.12, 4.10

Limits: 10 to 100

Default: 25

Notes: Under Tune\SET Parameters\File
System.

Maximum Transactions

This parameter sets the number of transactions that may occur at the same time. The
number indicates the system-wide maximum number of concurrent transactions.

Version(s): 3.11, 3.12, 4.10

Limits: 100 to 10000

Default: 10000

Notes: Under Tune\SET
Parameters\Transaction Tracking.

Minimum Compression Percentage Gain

This parameter is used to set the minimum percentage a file must compress to
remain in a compressed state.

Version(s): 4.10

Limits: 0 to 50

Default: 2

Notes: Under Tune\SET Parameters\File
System.

Minimum Directory Cache Buffers

This parameter sets the minimum number of cache buffers that the operating system
can allocate for directory caching. Set this parameter high enough that directory
searches can be done quickly. The number indicates the minimum number of
directory cache buffers to be allocated by the server before delaying.

Increase this parameter no higher than necessary. If the minimum number of cache
buffers is not used, the buffers cannot be reallocated to file caching. They remain
unusable.
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NOTE: If the file server is responding slowly to directory searches, use the
MONITOR.NLM or NetTune PRO to view current directory cache buffer statistics.

Version(s): 3.11, 3.12, 4.10

Limits: 10 to 2000

Default: 20

Notes: Under Tune\SET Parameters\Directory
Caching.

Minimum File Cache Buffers

This parameter sets the minimum number of cache buffers the operating system
allows for file caching. The operating system uses all memory not allocated for other
processes for file caching. As processes request memory, the operating system
releases memory until the limit of this parameter is reached. The number is the
number of file cache buffers to be left by the server (not allocated for other uses).

Setting this parameter too high may prevent other processes from allocating required
memory resources.

Version(s): 3.11, 3.12, 4.10

Limits: 20 to 1000

Default: 20

Notes: Under Tune\SET Parameters\File
Caching.

Minimum File Cache Buffer Report Threshold

This parameter sets a warning threshold above the minimum number of cache buffer
settings so that the operating system alerts you when the warning threshold has been
reached. The number indicates how close the number of cache buffers has to get to
the minimum before a warning is issued.

Warning Threshold Message:

Number of cache buffers is getting low.
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Regardless of how this parameter is set, the operating system displays the following
message when the memory allocation resources reach the minimum number of cache
buffers:

Cache memory allocator exceeded minimum cache buffer left limit.

Version(s): 3.11, 3.12, 4.10

Limits: 0 to 1000

Default: 20

Notes: Under Tune\SET Parameters\File
Caching.

Minimum File Delete Wait Time

This parameter sets the length of time a file must stay in a salvageable state on the
volume. Deleted files that have no minimum time requirements are not purged
automatically, even if the volume is full and users are unable to create new files. The
value is the minimum time to wait after a file is deleted before purging it.

Version(s): 3.11, 3.12, 4.10

Limits: 0 seconds to 7 days

Default: 1 minute 5.9 seconds

Notes: Under Tune\SET Parameters\File
System.

Minimum Free Memory for Garbage Collection

This parameter specifies the minimum free allocation bytes needed for garbage
collection.

Version(s): 4.10

Limits: 1000 to 1000000

Default: 8000

Notes: Under Tune\SET Parameters\Memory.

Minimum Packet Receive Buffers

This parameter sets the minimum number of packet receive buffers that the operating
system can allocate. The operating system sets the minimum number of buffers
when the server boots (STARTUP.NCF). The number is the minimum number of
packet receive buffers allocated by the server.

If you have EISA and Micro Channel server bus master boards in your server, and
you are receiving “No ECB available count” errors immediately after the file server
boots, increase this parameter. Each board needs to have at least 5 packet receive
buffers.
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NOTE: Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune PRO to view current server usage of packet receive buffers. If the
parameter is set higher than 10, and the server is responding slowly after it has been
booted, increase this parameter.

This parameter cannot be modified at the console prompt. SmartTune modifies the
STARTUP.NCF. Reboot the file server to implement the new parameter.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11, 3.12: 10 to 1000
4.10: 10 to 2000

Default: 3.11, 3.12: 100
4.10: 50 (SFT III systems=100)

Notes: Can be found in Tune\SET
Parameters\Communications.

Mirrored Devices Are Out of Sync Message Frequency

This parameter sets the frequency (in minutes) for checking out-of-sync devices.

Version(s): 4.10

Limits: 5 to 9999 minutes

Default: 30 minutes

Notes: Under Tune\SET Parameters\Disk.

NCP File Commit

This parameter controls whether applications are allowed to flush all pending file
writes to disk when a File Commit NCP is issued, instead of waiting for the cache
manager to flush to disk. When set ON, applications can flush all pending file writes
to the disk.

Set to ON to immediate flush from cache to disk when a File Commit NCP is issued.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File
System or NCP Parameters.

NCP Packet Signature Option

This parameter option controls the NCP packet signatures. The options to control
NCP Packet Signatures are: 0 = don’t do packet signatures; 1 = do packet signatures
only if client requires them; 2 = do packet signatures if the client can, but don’t
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require them if the client doesn’t support them; 3 = require packet signatures. After
startup time you can only increase the level. NCP Packet Signature prevents packet
forgery on servers and clients using NCP by requiring server and client to “sign”
each NCP packet.

NOTE: Because Packet Signature consumes CPU resources and slows performance
on both client and server, NCP Packet Signature is optional.

Version(s): 3.12, 4.10

Limits: 0 to 3

Default: 1

Notes: Under Tune\SET
Parameters\Communications or NCP
Parameters..

NDS Backlink Interval

This parameter is used to set the interval in minutes at which backlink consistency
checking is performed. Backlink consistency checking is executed as soon as you
change this value. It then recurs at the specified interval. A backlink indicates that an
object in a replica has an ID on a server where the replica doesn’t exist. This process
creates needed backlinks and deletes unnecessary ones.

Version(s): 4.10

Limits: 2 to 10080 minutes

Default: 780

Notes: Under Tune\SET Parameters\Directory
Services.

NDS Client NCP Retries

This parameter specifies the number of NCP retries before the NDS client times out
a connection. Lower settings are useful for smaller networks or those in which cables
are disconnected frequently. Higher settings are useful for larger networks with
heavy traffic. A setting of 4, 5, or 6 should be sufficient for large networks.

Version(s): 4.10

Limits: 1 to 20

Default: 3

Notes: Under Tune\SET Parameters\Directory
Services.
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NDS External Reference Life Span

This parameter specifies the number of hours unused external references are allowed
to exist before being removed. External references are local IDs assigned to users
when they access other servers. When users no longer have access, the external
references should be removed.

Version(s): 4.10

Limits: 1 to 384

Default: 192

Notes: Under Tune\SET Parameters\Directory
Services.

NDS Janitor Interval

This parameter sets the interval in minutes at which the janitor process is executed.
The janitor process is executed as soon as you change this value and then recurs at
the specified interval. The janitor process cleans up unused records, reclaims disk
space, and purges objects flagged for deletion.

Version(s): 4.10

Limits: 1 to 10080 minutes

Default: 60

Notes: Under Tune\SET
Parameters\Directory Services.

NDS Servers Status

This parameter is used to mark the status of all server objects in the local namebase
as UP or DOWN. Use this parameter to reset the status of all the servers if the status
of one server isn’t accurately recognized by the system. For example, if a server is
up but the system recognizes it as down, set this parameter to mark all servers as up.
Subsequently, the system would reassess the status of all servers and change the
status to down for those servers that were truly down.

Version(s): 4.10

Limits: UP, DOWN

Notes: Under Tune\SET Parameters\Directory
Services.
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NDS Synchronization Interval

This parameter is used to specify the maximum elapsed time between exhaustive
synchronization checks. As soon as you change this value, the system executes the
synchronization check. Synchronization checks then recur at the specified interval. If
the system has replicas across a WAN link, this value should be set as high as 240
minutes (4 hours) to reduce WAN traffic.

Version(s): 4.10

Limits: 2 to 1440 minutes

Default: 30

Notes: Under Tune\SET Parameters\Directory
Services.

NDS Synchronization Restrictions

This parameter specifies which versions of NetWare Directory Services the server
can synchronize with. To determine what version is currently loaded on a server,
type MODULES at the server prompt. The NetWare Directory Services version
number is displayed under the heading “DS.NLM.”

If this parameter is set to OFF, the server synchronizes with all versions available. If
this parameter is set to ON, the server synchronizes only with those versions
specified as parameters to the ON value. For example, ON,420,421

Version(s): 4.10

Limits: ON, OFF, List of version numbers.
Maximum length of version number
list: 132 characters.

Default: OFF

Notes: Under Tune\SET Parameters\Directory
Services.
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NDS Trace File Length to Zero

This parameter is used to delete the contents of the trace file. This parameter does
not delete the file itself. As soon as the file is cleared, the parameter resets to OFF.
To use this parameter, you must also set the NDS trace to file parameter to ON,
because the trace file must be open for the system to delete its contents.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Directory
Services.

NDS Trace Filename

This parameter is used to set the path and name of the NDS trace file on SYS:
volume.

Version(s): 4.10

Limits: Maximum length: 255

Default: SYSTEM\DSTRACE.DBG

Notes: Under Tune\SET Parameters\Directory
Services.

NDS Trace to File

This parameter sends messages about NDS events to the NDS trace file on the SYS:
volume. The default file is SYSTEM\DSTRACE.DBG. The file path and name can
be changed with the NDS Trace Filename parameter. The file is circular; it grows to
a maximum length of approximately 500 KB and then starts to overwrite itself at the
beginning of the file. If this parameter is set to ON, the trace information is also
scrolled on the screen.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Directory
Services.
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NDS Trace to Screen

This parameter enables the NDS trace screen, which displays information about
NDS events on the monitor.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Directory
Services.

New Packet Receive Buffer Wait Time

This parameter sets the length of time the operating system waits after receiving a
request for another packet receive buffer and before granting an additional buffer.
The value indicates the minimum time to wait before allocating a new packet receive
buffer.

This parameter is used to prevent the operating system from granting an abnormal
amount of packet receive buffers during a period of sudden peak usage.

WARNING: Never change this parameter on file servers with an EISA bus master
board.

Version(s): 3.11, 3.12, 4.10

Limits: 0.1 seconds to 20 seconds

Default: 0.1

Notes: Under Tune\SET
Parameters\Communications.
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New Service Process Wait Time

This parameter sets the length of time that the operating system waits to make the
allocation after receiving a request for another service process. The number is the
minimum time to wait before creating a new request servicing process.

Version(s): 3.11, 3.12, 4.10

Limits: 0.3 seconds to 20 seconds

Default: 2.2 seconds

Notes: Under Tune\SET
Parameters\Miscellaneous.

New Time With Daylight Savings Time Status

This parameter controls the adjustment of local time when daylight saving time is in
effect. If the parameter is set to ON, the local time is adjusted by adding or
subtracting the Daylight Saving Time Offset parameter.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time

Number of Frees for Garbage Collection

This parameter specifies the minimum number of times memory must be freed
before a garbage collection can occur.

Version(s): 4.10

Limits: 100 to 100000

Default: 5000

Notes: Under Tune\SET Parameters\Memory.

Number of Watchdog Packets

This parameter sets the number of watchdog packets the server sends out (without
receiving a workstation reply) before disconnecting the workstation. The value
indicates the number of times the file server will ask an inactive workstation if it is
still attached to the server before terminating the workstation’s connection if no
response has been received.

Version(s): 3.11, 3.12, 4.10

Limits: 5 to 100
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Default: 10

Notes: Under Tune\SET
Parameters\Communications.

Pseudo Preemption Count

This parameter specifies the number of times threads are allowed to make file read or
write system calls before a relinquish is forced.

Version(s): 4.10

Limits: 1 to 4294967295

Default: 10

Notes: Under Tune\SET
Parameters\Miscellaneous.

Pseudo Preemption Time

This parameter sets the amount of time available for certain NLMs to keep an NLM
process from using too much CPU time. The number is the amount of time (in .84
microsecond increments) to allow NLMs a process to run without relinquishing
before forcing a relinquish on the next file read or write system call (Pseudo
Preemption is enabled on a per NLM basis)

Set only as your NLM documentation recommends.

Version(s): 3.11, 3.12

Limits: 1000 to 10000

Default: 2000

Notes: Under Tune\SET
Parameters\Miscellaneous.

Read Ahead Enabled

This parameter performs background reads to move the block that is requested into
the cache in advance. Background reads are performed as long as sequential file
access is occurring. An ON setting indicates that while sequential file access occurs,
do background reads to get the blocks that will be requested soon into the cache in
advance.

Version(s): 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File
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Caching.

Read Ahead LRU Sitting Time Threshold

This parameter insures that if the LRU (Least Recently Used) sitting time is below
this threshold, then the read ahead does not take place.

Version(s): 3.12, 4.10

Limits: 0 seconds to 1 hour

Default: 10 seconds

Notes: Under Tune\SET Parameters\File
Caching.

Read Fault Emulation

This parameter specifies whether a read that occurs from a nonpresent page is
emulated.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\ Memory

Read Fault Notification

This parameter specifies whether the console and error log are notified of emulated
read page faults.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Memory.

Remirror Block Size

This parameter is used to set the remirror block size in 4 KB increments (1=4 KB,
2=8 KB, 8=32 KB, etc.).

Version(s): 4.10

Limits: 1 to 8

Default: 1

Notes: Under Tune\SET Parameters\Disk.
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Replace Console Prompt With Server Name

This parameter replaces the console prompt of “:” with the file server name.

Version(s): 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous.

Reply To Get Nearest Server

This parameter determines whether this server responds to “Get Nearest Server”
requests from workstations that are attempting to locate a server.

Version(s): 3.11, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Communications.

Reject NCP Packets with Bad Components

This parameter specifies whether NCP packets that fail component checking are
rejected.

Version(s):  4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\NCP.

Reject NCP Packets with Bad Lengths

This parameter specifies whether NCP packets that fail boundary checking are
rejected. This parameter can be used as a debugging tool.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\NCP.
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Reserved Buffers Below 16 Meg

This parameter sets the number of file cache buffers to be kept for device drivers
unable to access the memory above 16 MB. The number is the number of file cache
buffers to be kept for device drivers unable to access memory above 16 megabytes.

NOTE: This parameter cannot be modified at the console prompt. SmartTune
modifies the STARTUP.NCF. Reboot the file server to implement the new
parameter.

Version(s): 3.11, 3.12, 4.10

Limits: 3.11: 8 to 200
3.12, 4.10: 8 to 300

Default: 16

Notes: Under Tune\SET Parameters\File
Caching or Memory.

Server Log File Overflow Size

This parameter is used to specify the maximum size of the SYS$LOG.ERR file
before the action specified by the Server Log File State parameter occurs.

Version(s): 4.10

Limits: 65536 to 4294967295

Default: 4194304

Notes: Under Tune\SET Parameters\Error
Handling.

Server Log File State

This parameter controls what happens when the SYS$LOG.ERR file is larger than
the size specified by the Server Log File Overflow Size parameter. The options are:
0 = use to leave SYS$LOG.ERR as is; 1 = use to delete SYS$LOG.ERR; 2 = use to
rename SYS$ERR.LOG.

Version(s): 4.10

Limits: 0 to 2

Default: 1

Notes: Under Tune\SET Parameters\Error
Handling.
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Sound Bell for Alerts

This parameter controls whether a bell sounds when an alert message appears on the
console.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET
Parameters\Miscellaneous.

Start of Daylight Savings Time

This parameter is used to specify the local date and time when the change to daylight
saving time should occur.

IMPORTANT: You must set both the start and end of daylight saving time before
either date is actually scheduled.

Version(s): 4.10

Limits: Maximum: 79 characters

Notes: Under Tune\SET Parameters\Time.

TIMESYNC ADD Time Source

This parameter specifies a server as a time source. Use EDIT, rather than this
parameter, to add a server to the time source list in the TIMESYNC.CFG file.

Version(s): 4.10

Limits: Maximum: 48 characters

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Configuration File

This parameter is used to specify the path where the TIMESYNC.CFG configuration
file is located. For example, SET TIMESYNC CONFIGURATION FILE =
SYS:SYSTEM\TIMESYNC.CFG.

Version(s): 4.10

Limits: Maximum: 255 characters

Notes: Under Tune\SET Parameters\Time.
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TIMESYNC Configured Sources

This parameter is used to specify what time sources the server listens to. If set to
ON, the server ignores SAP time sources and relies on time sources that have been
custom-configured with the TIMESYNC Time Source parameter. If the parameter is
set to OFF, the server listens to any advertising time source.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Directory Tree Mode

This parameter controls the use of SAP packets in the Directory tree. If set to ON,
time synchronization ignores SAP packets that don’t originate from within the
Directory tree the server is on. If the parameter is set to OFF, the server can receive
SAP packets from any time source on the network.

NOTE: Do not set this parameter to OFF if SAP is set to ON. Using OFF could
corrupt the time synchronization for this server’s Directory tree.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Hardware Clock

This parameter controls hardware clock synchronization. If set to ON, the Primary
and Secondary time servers set the hardware clock, and the Single Reference and
Reference Servers set their time from the hardware clock at the beginning of each
polling interval. Turn this parameter OFF only if this server uses an external time
source (such as a radio clock).

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Time.
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TIMESYNC Polling Count

This parameter specifies how many time packets to exchange while polling.
Increasing the number of packets adds unnecessary traffic to the network.

Version(s): 4.10

Limits: 1 to 1000

Default: 3

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Polling Interval

This parameter specifies the long polling interval, in seconds. All servers in the same
tree must use the same setting.

Version(s): 4.10

Limits: 10 to 2678400 seconds (31 days).

Default: 600 seconds (10 minutes).

Notes: Under Tune\SET Parameters\Time.

TIMESYNC REMOVE Time Source

This parameter is used to delete a server as a time source. Use EDIT, rather than this
parameter, to delete a server from the time source list in the TIMESYNC.CFG file.

Version(s): 4.10

Limits: Maximum: 48 characters.

Notes: Under Tune\SET Parameters\Time.

TIMESYNC RESET

This parameter is used to reset time synchronization and clear the time source list.
Use EDIT, rather than this parameter, to reset values in the TIMESYNC.CFG file
and to remove the time source list from the file. If the parameter is set to ON,
selected internal values are reset and the configured server list is cleared. The flag
automatically resets to OFF.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time.
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TIMESYNC Restart Flag

This parameter controls restarts of time synchronization. Set this parameter to ON
only if you want to reload TIMESYNC without rebooting the server.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Service Advertising

This parameter controls time source advertising. If set to ON, the Single Reference,
Reference, and Primary time source advertise using SAP. Only set the parameter to
off if you are using a custom-configured list of time sources.

NOTE: Secondary time services do not advertise.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Synchronization Radius

This parameter is used to control the maximum time adjustment (in milliseconds) a
server is allowed while still being considered synchronized. Increase this parameter
to allow a wider margin of error for time synchronization between servers.

IMPORTANT: Lowering the synchronization radius increases the chance of servers
losing synchronization due to randomness between clocks. Setting the
synchronization radius for under 2000 milliseconds (2 seconds) is not
recommended. Set the synchronization radius for under 2 seconds only if you are
using an application that uses synchronized time stamps which do not tolerate a 2-
second deviation between time sources.

Version(s): 4.10

Limits: 0 to 2147483647 milliseconds

Default: 2000

Notes: Under Tune\SET Parameters\Time.
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TIMESYNC Time Adjustment

This parameter is used to specify when a time adjustment will take place.

NOTE: You cannot use this parameter on a Secondary time server.

Use this parameter sparingly to correct network-wide time errors. The default date
and time is six polling intervals or 1 hour (whichever is longer) from the current
time. Misuse of this parameter can corrupt time synchronization and the order of
events on your network.

Version(s): 4.10

Limits: [+ or -] hour:minute:second [at
month/day/ year hour:minute:second
AM or PM]
Maximum: 99 characters.

Default: None scheduled.

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Time Source

This parameter is used to specify a server as time source. If no server name is
entered, the parameter displays the list of configured servers. Use EDIT, rather than
this parameter, to add a server to the configuration list in the TIMESYNC.CFG file.

Version(s): 4.10

Limits: Maximum: 48 characters.

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Type

This parameter is used to specify the default time source type. Use EDIT, rather than
this parameter, to specify the default time source type in the TIMESYNC.CFG file.

Version(s): 4.10

Limits: Supported types: Reference, Primary,
Secondary, Single Reference.
Maximum: 23 characters.

Default: Single Reference.

Notes: Under Tune\SET Parameters\Time.
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TIMESYNC Write Parameters

This parameter is used to specify whether parameters specified by the “TIMESYNC
Write Value” parameter are written to the configuration file.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Time.

TIMESYNC Write Value

This parameter controls which parameters are written by “TIMESYNC Write
Parameters.” The options are: 1 = write internal parameters only; 2 = write
configured time sources only; 3 = write both parameters and configured time
sources.

Version(s): 4.10

Limits: 1 to 3

Default: 3

Notes: Under Tune\SET Parameters\Time.

Time Zone

This parameter specifies the time zone string, which indicates: the abbreviated time
zone name, the offset from Universal Time (UTC), the alternate abbreviated time
zone name to be used when daylight saving time is in effect. This parameter causes
UTC time to be recalculated from local time.

Version(s): 4.10

Limits: Maximum: 80 characters.

Default: No Time Zone.

Notes: Under Tune\SET Parameters\Time.

Turbo FAT Re-Use Wait Time

This parameter sets the length of time a turbo FAT buffer remains in memory after
an indexed file is closed. Once the wait state has elapsed, the operating system can
allocate the buffer to another indexed file. The number is the minimum amount of
time to wait before re-using a closed Turbo FAT.

Increase this parameter if you want the Turbo FAT index to remain in memory for
an extended period of time.
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Decrease this parameter if want memory immediately released to service the next file
to be indexed.

Version(s): 3.11, 3.12, 4.10

Limits: 0.3 seconds to 1 hour 5 minutes 54.6
seconds

Default: 5 minutes 29.6 seconds

Notes: Under Tune\SET Parameters\File
System.

TTS Abort Dump Flag

This parameter specifies whether a file is created to log transactional backout data. If
set to ON, the information is saved in TTS$LOG.ERR. If set to OFF, the information
backed out is not saved. When a server fails during a data write to a file flagged
Transactional, the system can back out the incomplete write. The backed-out
information is written to file TTS$LOG.ERR on volume SYS:. You can print the file
or view it with a text editor.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Transaction Tracking.

TTS Backout File Truncation Wait Time

This parameter sets the length of time allocated blocks remain available for the TTS
backout file when the blocks are not being used. The number is the minimum time
to wait before truncating the TTS backout file.

Version(s): 3.11, 3.12, 4.10

Limits: 1 minute 5.9 seconds to 1 day 2 hours
21 minutes 51.3 seconds

Default: 59 minutes 19.2 seconds

Notes: Under Tune\SET
Parameters\Transaction Tracking.
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TTS UnWritten Cache Wait Time

This parameter sets the length of time a block of transactional data can be held in
memory. In the case where a transactional data block has reached its time limit, other
write requests are held up while the data block is written to disk. The number
indicates the maximum time a cache buffer write can be delayed by the TTS.

Version(s): 3.11, 3.12, 4.10

Limits: 11 seconds to 10 minutes 59.1 seconds

Default: 1 minute 5.9 seconds

Notes: Under Tune\SET
Parameters\Transaction Tracking.

Upgrade Low Priority Threads

This parameter is used to specify whether low-priority threads are scheduled at
regular priority. Some modules can freeze up low-priority threads, causing file
compression to shut down and other problems.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET
Parameters\Miscellaneous.

Volume Log File Overflow Size

This parameter is used to specify the maximum size of the VOL$LOG.ERR file
before the action specified by the Volume Log File State parameter occurs.

Version(s): 4.10

Limits: 65536 to 4294967295

Default: 4194304

Notes: Under Tune\SET Parameters\Error
Handling.
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Volume Log File State

This parameter is used to control what happens when the VOL$LOG.ERR file is
larger than the size specified by the Volume Log File Overflow Size parameter. The
possible values are: 0 = use to leave VOL$LOG.ERR as is; 1 = use to delete
VOL$LOG.ERR; 2 = use to rename VOL$ERR.LOG.

Version(s): 4.10

Limits: 0 to 2

Default: 1

Notes: Under Tune\SET Parameters\Error
Handling.

Volume Low Warn All Users

Setting this parameter to ON will have the operating system warn all users when a
volume is almost full.  If you choose not to warn users, monitor volume statistics
daily with the NetWare CHKVOL or VOLINFO commands.

Version(s): 3.11, 3.12, 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\File
System.

Volume Low Warning Reset Threshold

This parameter sets the amount of disk space that must be freed before a second
warning is issued. The first warning is controlled by the “Volume Low Warn All
Users” parameter. The value is the number of disk blocks that are above the volume
low warning threshold where the warning trigger is reset.

If a volume is hovering at its volume low threshold, this parameter prevents
repetitious warnings every time the volume dips below the threshold.

Version(s): 3.11, 3.12, 4.10

Limits: 0 to 100000 blocks

Default: 256 blocks

Notes: Under Tune\SET Parameters\File
System.
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Volume Low Warning Threshold

This parameter sets the minimum amount of free disk blocks that can remain on a
volume before the operating system issues a warning. The number indicates the
threshold where a warning is issued that the volume is getting low on disk space
(number is in disk allocation units). The Block size is determined when a volume is
created.

Version(s): 3.11, 3.12, 4.10

Limits: 0 to 1000000 blocks

Default: 256 blocks

Notes: Under Tune\SET Parameters\File System.

Volume TTS Log File Overflow Size

This parameter is used to specify the maximum size of the TTS$LOG.ERR file
before the action specified by the Volume TTS Log File State parameter occurs.

Version(s): 4.10

Limits: 65536 to 4294967295

Default: 4194304

Notes: Under Tune\SET Parameters\Error
Handling.

Volume TTS Log File State

This parameter is used to control what happens when the TTS$LOG.ERR file is
larger than the size specified by the “Volume TTS Log File Overflow Size”
parameter. The possible values are: 0 = use to leave TTS$LOG.ERR as is; 1 = use to
delete TTS$LOG.ERR; 2 = use to rename TTS$ERR.LOG.

Version(s): 4.10

Limits: 0 to 2

Default: 1

Notes: Under Tune\SET Parameters\Error
Handling.
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Worker Thread Execute In a Row Count

This parameter specifies the number of times the scheduler consecutively dispatches
new work before allowing other threads to run.

Version(s): 4.10

Limits: 1 to 20

Default: 10

Notes: Under Tune\SET
Parameters\Miscellaneous.

Write Fault Emulation

The parameter specifies whether a write that occurs from a nonpresent page is
emulated.

Version(s): 4.10

Limits: ON, OFF

Default: OFF

Notes: Under Tune\SET Parameters\Memory.

Write Fault Notification

This parameter specifies whether the console and error log are notified of emulated
write page faults.

Version(s): 4.10

Limits: ON, OFF

Default: ON

Notes: Under Tune\SET Parameters\Memory.
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About NetTune PRO command, 97, 113
activity log, 54
adding servers to groups, 19
Advisor command, 36, 113
Application Window command, 112
Arrange Icons command, 30, 111
ASCII files

appending to existing file, 50, 93
automatic tuning, 46

B

backing up database files, 99
blocking text, 32

C

Cache Buffers Statistics command, 83, 108
Cascade command, 30, 111
changing recording intervals, 40
check mark, 25
Class Data Items List Box, 86
client installation, 11
Close command, 101
Communication SET parameters, 61
configuring servers, 38
connection information, 78
Connection Statistics command, 82, 106
Connections Summary command, 80, 105
context-sensitive help, 36
Copy command, 102
creating custom reports, 83
cursor movement, 33
custom reports, 83

displaying, 90
graph options, 88
saving, 91

Customize command, 108

Cut command, 34, 102

D

database files
backing up, 99

deleting
servers from groups, 22
text, 32

desktop
adding servers, 19
deleting servers, 22
saving, 31

Desktop group, 19
dialog boxes, 25

SET parameters, 58
directory caching parameters, 62
disabling logins, 44
disk parameters, 64
Disk Statistics command, 81, 106
displaying custom reports, 90
DLL files

problems, 100
Down Server command, 45, 110

E

Edit menu, 33, 102
Copy, 34, 102
Cut, 34, 102
Paste, 34, 103
Undo, 33, 102

editing
configuration files, 32
cursor movement, 33

ellipsis (...), 25
enabling logins, 44
enabling/disabling tune files, 69
Exit command, 102
exporting
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SET parameters, 75
tune files, 77

F

File menu, 101
Close, 101
Exit, 102
NCF, 101
Print, 101
Print Preview, 102
Print Setup, 102
Save, 101

File Server icon, 26
file system parameters, 62
files installed by NetTune PRO

client installation, 13
server installation, 18

Free Space Statistics command, 82, 107

G

graphs, 83
Group icon, 27
Group Management command, 110
Group Management Dialog Box, 20
groups

adding servers, 19
default, 19
deleting servers, 22
limits, 21
selecting servers from, 39

H

Help, 35
context-sensitive, 36
help on help, 36
index, 35
NetTune PRO Advisor, 36
printing topics, 37

Help menu, 112
About NetTune PRO, 113
Advisor, 113
Index, 112
Quick Start command, 113
Using Help, 112

hot fix redirection, 65
Hot Key icon, 83

I

Icons, 26
arranging, 30
NetTune PRO, 26
program icons, 26
toolbar, 27

Index command, 112
information

NetTune PRO, 79
Information menu, 103

Connections Summary, 80, 105
NLMs Loaded, 80, 104
Server Configuration, 104
SET Parameter Values, 80, 104

Information Text icon, 27
inserting text, 32
installation, 11

client, 11
NLM, 18
Quick Start dialog box, 15
server, 14
special notes, 17
Windows 3.1, 17
Windows for Workgroups, 17
workstation, 11

installation problems, 98
NetWare 3.11, 99
Windows 3.1, 17, 99
Windows for Workgroups, 17, 98

introduction, 8

K

keyboard navigation, 33

L

LAN information, 78
LAN Segment Statistics command, 82, 107
lock parameters, 62
logging in, 43
logging out, 43
Login command, 110
Login Status command, 44, 110
logins

enabling and disabling, 44
Logout command, 110
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M

manual tuning, 57
Maps menu, 108

Memory Pool, 108
NLM Memory, 108

memory maps, 95
memory parameters, 61
Memory Pool command, 108
Memory Statistics command, 82, 107
menu commands, 25
menu conventions, 25
menus

Edit, 33, 102
File, 101
Help, 35, 112
Information, 103
Maps, 108
Options, 109
Statistics, 81, 105
Tools, 109
Tune, 103
Window, 111

modifying default recording intervals, 40
modifying SET parameters

manually, 58
using tune files, 66

N

NCF command, 101
NetTune PRO

Advisor, 36
files on client, 13
information about, 97
installation, 11
introduction, 8
logging in and out, 43
menus, 101
system requirements, 10
upgrading NLMs, 99
user interface, 24

NetWare
SET Parameters, 114
version information, 78

NetWare 3.11, 99
network information

viewing, 78
Network Statistics command, 81, 106
NLM Install command, 109
NLM Memory command, 95, 108
NLMs

information, 78
installation, 18
loaded by NetTune PRO during installation, 18
upgrading NetTune PRO, 99

NLMs Loaded command, 80, 104

O

on-line help index, 35
optimization control, 47
Options menu, 109

Down Server, 110
Group Management, 110
Login, 110
Login Status, 110
Logout, 110
Save Settings on Exit, 110
Status Bar, 111
Toolbar, 110

P

packet receive buffer parameters, 61
Paste command, 34, 103
performance indicators, 55
Print command, 101
Print Preview command, 102
Print Setup command, 102
printing

Help topics, 37
reports to ASCII files, 50, 93
server configuration reports, 92
setting up printers, 94
SmartTune reports, 49
statistics, 92

problems, 100
DLL files, 100
installation, 98
RCONSOLE, 100

program icon
NetTune PRO, 26
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Q

quick analysis, 53
Quick Start command, 113
Quick Start dialog box, 15

R

RCONSOLE, 22
problems, 100

RCONSOLE command, 109
read after-write-verification hot fix redirection, 65
Read Ratio Statistics command, 82, 107
read request hot fix redirection, 65
recording intervals

changing, 40
database files, 41
default, 40

Recording Intervals command, 108
reference and support documentation, 23
release notes, 100
reports

custom, 83
NLM memory, 95
text, 83

S

Save command, 101
Save Settings on Exit command, 110
saving

custom reports, 91
the desktop, 31

scheduling tune files, 68
selecting

servers, 39
tune files, 68

server configuration
printing reports, 92

Server Configuration command, 104
servers

configuring, 38
installation, 14
selecting, 39
taking down, 45

SET Parameter Values command, 80, 104
SET parameters, 57, 114

alphabetical list, 114

communications, 61
dialog boxes, 58
directory caching, 62
disk, 64
exporting, 75
file system, 62
locks, 62
memory, 61
modifying manually, 58
modifying using tune files, 66
packet receive buffer parameters, 61
range information, 78
transaction tracking, 64
watchdog parameters, 61

SET Parameters command, 57, 103
setting up printers, 94
setup program, 11
SETUP.EXE file, 11
shutting down servers, 45
SmartTune, 46

activity log, 54
disabling, 47
optimization control, 47
performance indicators, 55
printing reports, 49
quick analysis, 53
selecting a server, 49
tuning options, 48

SmartTune command, 103
Statistical Report icon, 26
statistics

graphs, 83
printing, 92
text reports, 83
viewing, 81

Statistics menu, 81, 105
Cache Buffers Statistics, 108
Connection Statistics, 106
Customize, 108
Disk Statistics, 106
Free Space Statistics, 107
LAN Segment Statistics, 107
Memory Statistics, 107
Network Statistics, 106
Read Ratio Statistics, 107
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Recording Intervals, 108
Utilization Statistics, 106
Volume Statistics, 106

status bar, 29
Status Bar command, 111
system requirements, 10

T

taking down the server, 45
text

reports, 83
working with, 32

Tile Horizontal command, 30, 111
Tile Vertical command, 30, 111
Time Tune command, 68, 103
toolbar, 27

icons, 27
Toolbar command, 110
Tools menu, 109

NLM Install, 109
RCONSOLE, 109

transaction tracking parameters, 64
triangle, 25
troubleshooting

DLL files, 100
installation, 98
RCONSOLE, 100

tune files, 66, 68
enabling/disabling, 69
exporting, 77
sample, 70
scheduling, 68
selecting, 68

Tune menu, 103
SET Parameters, 57, 103
SmartTune, 103
Time Tune, 103

tuning
automatic, 46
manual, 57
options, 48

U

Undo command, 33, 102
upgrading NetTune PRO NLMs, 99
user interface, 24

dialog boxes, 25
icons, 26
keyboard, 33
menu commands, 25
status bar, 29
toolbar, 27
using icons, 30
using windows, 30

Using Help command, 112
Utilization Statistics command, 82, 106

V

viewing
network information, 78
statistics, 81

volume
information, 78
statistics, 82

Volume Statistics command, 106

W

watchdog parameters, 61
Window menu, 111

Application Window, 112
Arrange Icons, 111
Cascade, 111
Tile Horizontal, 111
Tile Vertical, 111

windows
arranging, 30
selecting, 30

Windows 3.1, 17, 99
Windows for Workgroups, 17, 98
Windows Help, 35

help on using, 36
index, 35

workstation installation, 11
write request hot fix redirection, 64
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